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Introduction

I
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Introduction

Introducing Inepro Back Office Suite - CashPROUser Management
Welcome to the Inepro Back Office Suite - CashPROUser Management. This manual will treat the CashPROUser
Management module.
CashPRO is financial accounting software used to control vending machines and cash registers
Inepro has tried to cover every aspect of the Inepro Back Office Suite - CashPROUser Management in this manual.
This first part of this manual will address the installation and setup of the Inepro Back Office Suite software on the system.
Then the changes in relation to the last release will be discussed. Furthermore we will shortly treat the hardware and
software installation. Then the GUI and menu structure will be explored. Finally we will treat the configuration, common
tasks and troubleshooting. There will be a glossary, appendices and, in the printed versions, an index.
The Glossary chapter handles all the relevant phrases and keywords used within the Inepro Back Office Suite and in this
manual.

Overview IBOS
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What's new?

II

Part

What's new?

What's new?
Added functions
These functions are new in this release:

Legend
(
(
(
(

) Added feature
) Improved/ changed feature
) Bug fix
) Dropped feature

DocuPRO4
· Setting: “use anonymous job codes per job”. When set to true, the client will show a job code once and will not keep job

history.
· Date expired cost centers will not be visible in customer and department details selection.
· Job Property Mapper: "LPD_DomainName". This Job property mapper adds the domain name to the username so that

users with the same username but belonging to different domains van collect their own job using secure release.
· Setting “hide job name in follow me queue”. Jobs can be renamed to “DocuPRO Document” when job is forwarded based

on printer rules.

Inepro Client Popup
· Notification dialog, shown when corrupted print jobs are detected.

Inepro Scan Engine
· XPS job scanner.

Inepro Printer driver
·
·
·
·
·
·
·

Printer Pools, Job Time To Live and Daily purge.
Inepro Cloud Printing support.
Restructured print job logging.
Job code print jobs with customer codes are now linked to customers.
Job change options.
Dutch translations.
Added Job Property Mapper LPD_DomainName.

Inepro Cloud Printing (ICP)
· Inepro Cloud Printer terminals receive print jobs for all follow-me pools.
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Inepro Business Server (IBS)
·
·
·
·
·
·
·
·
·
·
·
·
·
·
·
·
·
·
·
·
·

PC TimerPRO support.
Print jobs that cannot be released are shown on terminals .
Setting “Allow Job Property Modification”.
“Reload settings” button to Business Server config tool. This button makes it possible to load new settings to the
terminal, without a restart of the service.
Reliability check of MIB Data.
Several MIB Settings.
Usage of application types “Copy” and “Print_Copy”.
Setting "Disallow fuzzy tag reads".
Setting “Default application” for open API devices.
Support for Scan To X.
Support for Job Codes.
Setting "Session Timeout" to ignore account locks.
Job change options.
German language in Business Server config tool
Release and display order of print jobs.
DocuPRO 4 job code support.
Number of job code digits are automatically increased or decreased.
Setting "Job code time-to-live".
New LDAP authentication plug-in.
Terminal versions and addresses are written in database.
Template fallback options for MIB counters nonexistent in template. When transaction is corrected by the MIB server and
the product is unknown in the product template a price fallback will be adjusted so that the transaction can be stored in
the database.

Inepro Data Import Service (IDIS)
·
·
·
·
·
·
·

Language code and Photo Path Template.
GUI is now translatable.
Last Update offset setting.
Option to prefix customer code with same prefix as Windows username.
Dutch language in user interface.
German language in user interface.
LDAP authentication now supports Microsoft LDAP server signing protocol.

Inepro Database
· Station types for Inepro Cloud Printing and PC TimerPRO
· Valid To and Valid From fields to Items.

Inepro License Server
· New license types for Inepro Cloud Printing.

Inepro Reporting
· Report tool shortcut to Windows Start menu during setup.

Inepro Application Service Manager
· Support Inepro Biometric Service
· Support Inepro Cloud Printing.
· Inepro Service Manager: Ignore stop commands while in restore mode.

Inepro PayCon Server
· Functionality to disable (PayCon II) terminals remotely for maintenance.

5

What's new?

Enhanced functions
DocuPRO 4
· Optimized job renaming in DocuPRO 4 for better results and performance.

Inepro Data Import Service (IDIS)
· Improved photo-import performance in IDIS.
· IDIS templates are now stored in Windows Program Data folder.

Inepro PayCon Server
· Extended cost center protocol to use default cost center when no user-interface available.

Inepro License Server
· Respect Inepro Data Path setting.
· No longer started during setup when database installation selected.
· No longer installed automatically on the database server.

Inepro First Time Login
· Multi language version of “First Time Logon” now available.

Inepro Business Server (IBS)
· System defaults can no longer be edited in Business Server Config Tool.

Dropped functions
Inepro Back Office Manager
· Dropped "Login as a different user" function.
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Hardware Installation
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Hardware Installation

Hardware Installation
Administrative Terminal
Preparation
Make sure the terminal is configured as a POS Terminal.
Set the IP-address as fixed in the terminal.

On site
Make sure the terminal is able to use it's fixed IP-address.
Connect the serial cable to the computer and/or plug the network cable into a available network socket.
Connect the power cable to an available power outlet.
The Administrative terminal can be connected via the network instead of using the serial cable.
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Card Printer
Preparation
Before the card printer can be used in the system an Inepro Administrative terminal must be connected.
Make sure that a power outlet is available at the location of the card printer.

On site
Connect the device to a power outlet, connect the serial cable to the Administrative Terminal and the USB cable to the
workstation.
The printer should be visible in the OS, go to www.fargo.com or use the included driver CD if drivers are required.
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Hardware Installation

License box
Preparation
Determine a place to mount or keep the Inepro licence box.
Make sure that a network and power outlet are available at the location of the license box.

On site
Connect the Inepro License box to a power outlet and their network cable(s) to a network outlet.

10

-

IBOS CashPRO

Vending machines
Preparation
Before a vending machine can be used in the system an Inepro terminal must be installed.
Installing a terminal in a vending machine is a task that can only be executed by an Inepro Certified Engineer, ask the
vendor for such an engineer when adding or removing vending machines to or from the system.
Make sure that the required data such as the IP address (or IP-range) of this terminal and the address of the server are
known by Inepro.
Make sure that a network and power outlet are available at the location of the vending machine. The terminal is powered
by the vending machine and does not require an additional power outlet.
Soup / Coffee / Orange juice machines and machines alike are also considered vending machines!

On site
Connect the vending machine to a power outlet and the network cable to a network outlet.
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Hardware Installation

PosPRO till
Preparation
Installing and configuring a PosPRO cash register or till for first time use is a task that can only be executed by an
Inepro Certified Engineer, ask the vendor for such an engineer when adding or removing such machines to or from the
system.
Make sure that the required data such as the IP address (or IP-range) of this PosPRO till and the address of the server
are known by Inepro.
Make sure that a network and power outlet are available at the location of the till.

On site
Connect the PosPRO till to a power outlet and the network cable to a network outlet.
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Software installation

Software installation
Prerequisites:
§ A valid license box connected to the network.
§ A server with Microsoft SQL server running - setup with the Inepro specifications (SQL login credentials must be enabled

(mixed Mode) among other settings) or the database.
§ A valid Inepro license key file.

Recommended work plan:
§
§
§
§
§
§
§

Install the database and license server on the database server
Configure the license box and license server.
Load the license.
Install the Inepro Business server.
Install the DocuPRO components on the print server.
Install the ScanToXServer (if used) (separate setup).
Install the satellite components and software like the Inepro managers and mini-clients (separate setup).

1. Splash screen.
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2.

Language Screen

Select your language, in this language the software will be installed, and if this is the first time you install the database the
database fields will also be in this language, click 'OK'.

3. Welcom e Screen

This will inform you of the software version, click 'Next'.
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4.

License Agreem ent

Read the license, select 'I accept the agreement' and click 'Next'.

5. Select Destination Location

Select the folder where to install the Inepro Back Office Suite, click 'Next'.
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6. Select Com ponents

Select the components that must be installed, note that most services often only need to be installed one 1 server, just like
the database and license server must normally only be installed in one location in the system.
So carefully analyse what is needed at this location before the components are chosen.
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7. DocuPRO spooler options

The DocuPRO spooler options specify some very important options for the DocuPRO spooler.
Security: When optimized for security, the data is encrypted this is more secure but will take a little bit longer to process.
When optimized for performance, the data is not encrypted (like a normal print job in Windows).
Print job previews will show you a graphic preview of the job, this will require more internal memory and disk space, but
gives a better user experience.
Not using Print job previews will lighten the server load. The impact this has depends on the number of jobs that are on the
server on the same time.
Use Inepro LPD service, will use Inepro's own LPD service instead of using the Windows LPD service. This will be used in
those cases where the Windows LPD service cannot provide the required functionality. Please refer to documentation or a
Inepro Certified Engineer if this is required. By default the Windows LPD should be used.
Path, this is the location where the print data (spool files) are stored. Click 'Next'.
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8. Database

Database, fill out the location of the SQL server, the database (catalog) and the credentials (inepro's default credentials will
be used by default, when other credentials must be used, these must also be created in the SQL database for the IBOS
catalog).
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9. Select Start Menu Folder

Select the Start Menu folder.
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10. Select Additional Tasks

Unless the database is installed on this machine, the database wizard should not be run.
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11. Ready to Install

The Ready to install screen will give you an overview of the installation choices.
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12. Preparing to install
13. Preparing to install; files still open.

14. Installing - Closing applications
15. Installing

If there are still Inepro files open, a warning will be issued, if so click 'Next'.
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16. Finished

The setup is finished, if the database was created / upgraded, and a license box was installed with a valid license, the
Inepro Back Office Manager should start.
If not uncheck the 'Launch Inepro Back Office Manager' box and make sure this issues are attended to first.
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Wizard

Wizard
When the Inepro Back Office Manager is started for the first time, a wizard is started to assist in setting and defining the
basic elements of the IBOS system.
The possibilities of the dialog screens are treated in this section.

Prerequisites:
§ None

Where
§ Main Menu\Tools\Wizard...

The wizard can be started manually, or is started automatically at the first-time-use.
First the welcome screen is shown, which will give some idea on what stages to expect during the setup wizard.

25
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Fill out the name of the Organisation.

Fill out the name of the Location.
Site is the place where a device, user or Terminal is physically located. It is the smallest group of the hierarchical structure
of an organisation and it is mandatory.

Fill out the Site data.
One Site must be set as the 'main' or 'activated Site'. If a site is not yet set to 'active', it can be set by clicking the
button.
Only if a Site has been set to 'active' the wizard can continue and the

button will be enabled.

When no authentication data is entered everybody can start the Back Office Manager and has access to all functionalities
offered by this version of the Inepro Back Office Suite.

Access by employees can be limited or granted

If the step will be skipped at this point, press [Next].
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Wizard

When a PayCon is connected to the serial port of the computer running Back Office Manager or to the network, a large
number of card management features are provided. Should there be a PayCon connected, check the [Administrative
PayCon] check box and select either the serial port it uses or it's IP-address. When a serial port is used the 'Use COM
port' box should be checked.

At Budget Location choose between Cards, Online Account or Both. If either Cards or Online Accounts is chosen, the
other option will disappear from the menu.
Read more about Budget Locations in the chapter:
Account / Card Settings on page:
Product groups can be used to manage the Products and Paper Prices easier.
By default a small number of product groups are provided. The product groups can be added, deleted or modified now or in
a later session via the menu.

Read more about Product Groups in the chapter:
products on page:
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The Inepro Back Office Suite comes with a number of pre-defined Products and Paper Prices. These can be added,
deleted or modified now or in a later session via the menu. Keep in mind that this is a good moment to set the prices of
the basic products.

Read more about products or Paper Prices in the chapter:
products on page:
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Wizard

Product Templates are templates of Products or Paper Prices for a specific device. Thanks to these Product Templates
the same configuration can be assigned to a large number of devices.
It is possible to add, delete, or modify these templates.

Read more about Product Templates in the chapter:
Product Templates on page:

Printer Pools are groups of printer queues. These groups are used for printer rules and other grouping applications.

Read more about Product Templates in the chapter:
Printer Pools on page:

When the DocuPRO Server has been installed all local printers are added to the database. All other devices need to be
added manually.
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Steps

Steps
In this section we will provide the steps to take to perform common tasks, like creating a card, or revalue an account.

Determine System Model
Before an installation or an major system upgrade / extension can be started, an evaluation must be made what kind of
system model must be used.
In this section we will go trough the possibilities.
In order to understand the different configurations it is necessary to know the different modules and what they do:
DocuPRO
DocuPRO is the module that manages and registers print, scan and copy traffic and/or sells those products.
Inepro Back Office Manager
The Inepro Back Office Manager is the Graphical User Interface of the Inepro Back Office Suite.
AccessPRO
AccessPRO is the module that manages and registers access ports and zones controlling and registering the flow of
people going in and out of the site building.
CashPRO / PosPRO
CashPRO manages the PosPRO cash registers and the vending machines and other CashPRO devices, providing insight
and control of the product flow.
AbsencePRO
Absence registration software to register the absence of students or employees usually in an external third-part database.
AbsencePRO will connect with the Absence terminals in the background and will show absence details in the reports
accessible in the Inepro Back Office manager.
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Determine System Model

When to use the Stored Value Server Environment
When a IBOS system is set up as a 'Stored Value Server Environment' all relevant balance and account information is
stored on the server.
This means the user only needs a way to point to this account information.
This can be done with a wide variety of possibilities: PIN-codes, cards (ID-only) …

Some of the advantages are:
§ Because the system only needs an ID to recognize the user a wider number of login methods can be used, including PIN

code identification
§ No need to write data on an existing customer card
§ Accounts can be credited without the user and or card present

Supported technologies:
§
§
§
§
§
§
§
§

Contact chip card
Magnetic stripe card
Mifare proximity card
Legic proximity card
Hitag proximity card
Barcode card
Proximity card
...

When to use the Stored Value Card Environment
When a IBOS system is set up as a 'Stored Value Card Environment' all relevant balance and account information is stored
on the user's card.

Some of the advantages are:
§
§
§

Each user takes more care of his card because his money is on this card
Can be used with non-networked payment systems
Even if the network is down a large number of functions still can be executed by the system

Supported technologies:
§
§

Contact chip card
Mifare proximity card
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Determine Network Configuration
There are a lot of different network setups which are possible. In this chapter a number of possible configurations are
shown.

Network configurations
A. Stand-alone configuration

Page

B. Central server, remote management

Page

C. Single site, 1 database server, 1 print server, and remote management

Page

D. Single site, 1 database server, 2 print servers, and remote management

Page

Multiple sites, 1 database server, 2 print servers, and remote
E.
management

Page

Stand-alone configuration
In the stand-alone configuration all modules are installed on 1 machine:

In the stand-alone configuration all modules are installed on 1 machine:

All modules connect to the IBOS database for information synchronization. In a print environment all client computers
connect to this (print-) server and use the shared printers for printing (not in diagram).
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Determine System Model

1 central server, remote management
All the server tasks remain concentrated on a single server, the configuration of the software is done via a workstation in the
network which has a database connection to the server.
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Single site, 1 database server, 1 print server, and remote
management
The database resides on a dedicated database server, all server modules on the print server connect via the network to the
database server, and also the Inepro Back Office Manager on the workstation connects to the central database.
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Determine System Model

Single site, 1 database server, 2 print servers, and remote
management
The database resides on a dedicated database server. The first print server has the module to communicate with all
Terminals in the network and he manages his local print queues. The second print server only manages his local print
queues. The workstation can manage the complete setup from 1 single point of maintenance.

The print queues on the server that doesn't have PCS (PayCon Service) running will NOT be accessible by the
Terminals on the network!
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Multiple sites, 1 database server, 2 print servers, and remote
management
This is one sample of how a more complex network could look like. The sample has a central site where the database
server resides, and the some of the management is done. Furthermore are there 2 remote sites with live connection to the
database that handle their own print jobs and control the local networked Terminals. All three locations are able to use the
User management options via the Back Office Manager.
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Define
In this section we will define the values needed in the system.

Attach a Admin PayCon and/or Card Printer
Prerequisites:
§
§
§
§
§

Admin PayCon connected to either the workstation or network
Card Printer connected (if used)
Card Printer Licence (if used)
Subscription Printer connected (if used)
Subscription Printer Licence (if used)

Where
§ Main Menu\Tools\Connection Settings

Attach a Admin PayCon and/or Card Printer
The Inepro Back Office Suite can be ordered with a card printer and an Administrative PayCon.

1. In the 'Tool' menu, choose 'Connection Settings' and check
'Administrative PayCon'. Select if the PayCon is connected trough a
COM port or via the network using TCP/IP. When it is connected via the
network set the IP-address.
2. Check if the PayCon is connected to the printer.
3. Make sure the printer is installed in windows with the correct printer
drivers and the USB cable is connected to the PC. It should also be
recognised by our software as a printer.
4. Check 'Use Card Printer' and select the kind of Cards that it can create
(Chip Cards, Mifare Cards or both).
5. Press 'OK' and restart the services and the software.
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Assign Authorization Rights
Prerequisites:
§ None

Where
§ Main Menu\Advanced\Authentication

Assign Right Profiles
To grant right to an employee, an employee must first be created with General Manager rights (all available rights). Then
another employee can be created with less rights.
There are three ways to define a customized rights profile:
§ Preselect a template
§ Placing or removing check marks at the check boxes for every right
§ Using the Enable User Rights Admin function
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Create employee

Press the Add button

to open the new / insert menu or the Edit button

to edit already existing data:

Login is the name the employee will use to log in on the Inepro Back Office Manager.
The First Name, Infix, Last Name and the password fields are self explanatory. The Employee Code and Employee PIN are
used for PosPRO employees. So if the employee should also be able to access one or more PosPRO tills, his credentials
should be submitted here.
On the bottom these buttons are visible:
Button

Description

Set Default Rights

Choose a template from the default templates.

Set Rights

Copy Template from existing template, and enable or disable rights per module.

Save Rights

Save current selected rights as a new template.

OK

Confirm changes and close w indow .

Cancel

Abort changes and close w indow .
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Assigning Rights
Preselect a template
These are the default rights profiles that can be assigned to different employees:
Right

Description

Back Office Supervisor

Grants a user full access to view and / or change all modules of the Back Office Manager softw are.

DocuPRO devices

View or make changes in the menu's DocuPRO Devices, Update Terminals, Restart Services and Device History

CashPRO devices

View or make changes in the menu's CashPRO Devices, Update Terminals and Device History

DocuPRO products

View or make changes in the menu's Paper Prices, Update Terminals and Restart Services

CashPRO products

View or make changes in the menu's CashPRO Products and Update Terminals

Hardw are configuration

View or make changes in the menu's Device Configurations, Terminals, Servers, Printer Pools, Printer Presets,
Deleted Terminals, Deleted Devices, Update Terminals, Restart Services and Device History

Reporting groups

View or make changes in the menu's Device Groups and Product Groups

Discounts

View or make changes in the menu Discounts

Organisational structure

View or make changes in the menu's Organisation, Locations, Sites, Departments and Cost Centres

User Management

View or make changes in the menu's Cards, Online Accounts, Users, User History, Marketing, Device History
and Anonymous Cards

Reports

View or make changes in the menu's Turnover Report, Total sum of amounts and Device

User Reports

View or make changes in the menu's all reports, except Turnover Report, Total sum of amounts and Device

Click 'Set default rights', select the appropriate template and click 'OK'.
'Set Rights' can also be used to select a custom template. Either use that template (click OK), or change that template by
enabling or disabling modules, or by enabling or disabling check boxes in the list below. After that either save those rights
as a new template and click OK, or click OK directly.

Manually
Tick the boxes for each right the employee must have. The boxes of the rights he should not have should be empty.
As this list quite voluminous, we recommend using the Enable User Rights Admin function.
The methods 'preselecting rights' and 'assigning manually' can be use in conjunction with each other. The resulting set
can then be saved.

Using Enable User Rights Administrator
Enable User Rights Administrator will enable can be used to administer different function rights within the Inepro Back
Office Manager in a instinctive visual manner. The desired functions are simply accessed while the Inepro Back Office
Manager is in the User Rights Administrator mode (uncheck the checkbox 'Execute default action', so that the action isn't
executed while assigning rights).
Before the rights can be edited make sure multiple employees are created, where at least one of the employees must
have general manager rights and one of the others (may also be General Manager) is currently logged in.
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User Rights Administrator - example

1. For this exam ple tw o em ployees; Bob and Ronald have been created, w here Bob is the general m anager. Please m ake sure
that tw o em ployees have been created.

2. Click on 'Enable User Rights Adm in' in the Tools m enu.

3. There w ill only be a couple of seconds before the default action is started! Uncheck the tick box 'Execute default action'.
4. By unchecking the tick box, Ronald's right to view AccessPRO devices is revoked.
5. Because 'Execute Default Action' w as unchecked, the AccessPRO Devices w indow w ill not be show n if I press
6. Press

.

.

7. To stop the 'User Rights Adm in' m ode, click 'Enable User Rights Adm in' in the Tools m enu like in step 2 once m ore, leave
'Execute Default Action' on and press
.
8. The 'User Rights Adm in' function has now been closed.
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Users
Prerequisites:
§ None

Where
§ Main Menu\Basic\Users
§ Side Bar Menu\Users

Users
Here Users can be created, all user information can be added. Once a User is created he can be linked to an Account or
Card depending on the system model.

The Users properties:
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Photo

Photo of the user. This can be a *.jpg, *.jpeg, *.gif, *.bmp, *.w mf, *emf or *.ico file.

User Code

Unique number to identify the user.

Departm ent

Assign the user to this Department

- other fields -

These field are easy to understand

Default Cost Centre

The default Cost Centre is the Cost Centre that the costs w ill be booked to chosen if no
other choice has been made

Mailing

Does the user w ant to receive marketing information

Bar Code

Barcode is a field that is used to print a bar code on a User card w ith the print lay-out.
Usually this is also the User Code but sometimes bar code specific stop and start
characters like 'A' are necessary for the bar code to w ork.

Valid From

This field can set a date from w hich the user can use the system, set by default to 1-11900.

Valid Trough

This field can set an end date through the user can use the system, set by default to 1-12100.

Default Card / Account

This is used w hen the user has more then one card / account. This field w ill specify w hich
'Tender' (card or account) is primarily used for payment.

Personal Balance

The current amount of Personal Balance of this User

Printed

When printing user cards it is very useful to see w hich cards have already been printed.
This field w ill be set to 'true' if a card is printed.

Current Access Zone

Set The current Acces Zone of the User.
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Photo
In the photo field a picture can be loaded. This is accomplished by right-clicking the photo area to enter the context menu
(left-clicking will show an example of the picture).

Capture photo
Load photo from file Load a photo from a file on the current hard disk(s). Select a photo on the hard disk.
Capture photo
Capture a photo using a w ebcam. Press 'Capture' w hen the photo is satisfactory.
Save photo to disk
Save the photo to a location on the disk. Select a location on the hard disk.
Delete photo
Copy to clipboard
Full size preview

Delete the photo.
Copy the photo to the Window s clipboard. Paste it again in Paint or any other image
editor.
Show the picture in the resolution it is stored in.

Context Menu

Export Users to XML
Im port Users from XML
Go To User Log
Create Chip Cards

Create Mifare Cards

Export the selected Users to a XML file
Import the Users in this XML file
Link to User Log
If a card printer w ith a chip card reader is available,
chip cards can be created that are added to the
database just before printing.
If a card printer w ith a Mifare card reader is
available, Mifare cards can be created that are
added to the database just before printing. (An
ECOS SAM is required to create Mifare cards).
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Cards
Prerequisites:
§
§
§
§

Users
Card Printer connected & configured (For printing or printing and creating)
Admin Terminal connected & configured (for creating or printing and creating)
Card Layout defined (for creating or printing and creating)

Where
§ Main Menu\Basic\Cards
§ Side Bar Menu\Cards

Cards
Cards (in Inepro terminology) are objects that have a chip (either pure on the inside, or also visible from the outside), that
can store data (for example; the users current balance) and have a unique ID.
Here the card data can be specified. Cards can only be used in either a combined or Stored Value Card system, just like
tags can only be used in a combined or Store Value Server system. Look up the difference here.
A standard Inepro Card Printer will not print chip cards, only Mifare cards, if printed chip cards are needed, then this
option needs to be specifically ordered. Contact the Inepro account manager assigned to your organisation.

The Cards Dialog properties
First screen:
User Code

Unique number to identify the User.

User

The User linked to this card

Card Num ber

The unique number of the card.

Card Type

Defines the type of chip card, like SLE4442, Mifare.

Card Group

The group that this card is part of.

Subscription

The subscription of the user.

Status

This field indicates w hether the card has been blocked or not.

Valid From

The start date of the time period the card is valid.

Valid Trough

The end date of the time period the card is valid.

External Access
Zones

A maximum of six different external Access Zones

Changed

This is a timestamp (notation of date and time) that is created w hen this record is altered.

PIN Code

The PIN code of this card

Show code

Show the code?

Pin Code
required

Will the code alw ays be required?

Second screen:
The field 'Purse Sub Type' consist of the Purse Type and the Purse Sub Type, for example 'Balance' + 'Personal', where
'Balance is the 'Purse Type', and 'Personal' the 'Purse Sub Type'.
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Purse Sub Type

What is the target use of the budget

Purse Type

Is it a balance or a unlimited budget?

Balance

What is the balance?

View
View the current data and the changes that are scheduled to occur
real/scheduled data

View the current data and the changes that are scheduled to occur

Third screen:
Card Group
Layout

The card group linked to the Card Group

Overw rite With

Overw rite w ith this Card Group

Creating a card with the Admin Terminal
Prerequisites:
§ Admin Terminal connected & configured

Creating a card with the Admin Terminal
Simply create by presenting a card to the Admin Terminal.

Empty card on the PayCon (SVC system only)
1.
2.
3.
4.
5.

Put Card on Admin PayCon, the card screen pops-up.
Check and if not correct change user or user code to the desire user
Check and if not correct change the other information press next
Check and if not correct change the purses, press next
Finish

Create card from the User menu without printing it
1. Select the User(s)
2. Right click (one of) the user(s)
3. Pick 'Create Card => Create <Card Technology Type> card with a Administrative Terminal (Where <Card Technology
Type>) is either a proximity card or a chip card.
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Print and Create User Cards
Prerequisites:
§ Card Printer connected & configured (For printing or printing and creating)
§ Admin Terminal connected & configured (for creating or printing and creating)
§ Card Layout defined

Where
§ Main Menu\Basic\Cards

Print and Create User Cards
The card printer enables the printing of cards and connects them at the same time to the Users in the Inepro database in
batches.
This means cards can be printed for every User in the database without having to create every card manually with the
Administrative PayCon and the design of the User cards can be edited.

From the card menu (If a card printer is connected the card can also be printed)
1. Press 'Add Card' Icon
2. Put the Empty card on the PayCon if the must not be printed, if it does choose 'Create <Card technology> card with
Card Printer' (Where <Card Technology> is the card technology chip card or Mifare.
3. Change user or user code to the desire user
4. Check and if not correct change the other information press next
5. Check and if not correct change the purses, press next
6. Check and if not correct change the Card Layout
7. Finish (if chosen, the card will now be printed)

Create and print card from the User menu
1. Select the User(s)
2. Right click (one of) the user(s)
3. Pick 'Create Card => Create <Card Technology Type> card with a card printer (Where <Card Technology Type>) is
either a proximity card or a chip card.
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Create Cards with the Card Printer
Prerequisites:
§ Card Printer connected & configured
§ Admin Terminal connected & configured
§ Card Layout defined

Where
§ Main Menu\Basic\Cards

Create Cards with the card printer
Create and print multiple cards in one go.
When the card printer that can create cards while printing them is available, that printer can be used to create user card,
saving the time and the expenses to do both processes separately.
Before card can be created and printed the card printer has be connected to our software.
Read more about connecting a Card Printer in the chapter:
How to connect a Card Printer on page:
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1. Go to the context menu of the selected user(s) in the Users screen:

2. Choose Create Mifare cards for the creation of Mifare cards and Create Chip cards for the creation of chip cards.

3. Select the Card Group the selected user(s) belong to and the validation period.
4. Click

. Select the appropriate Card Purses. Click

.

5. Check if the group layout is correct, and if not overwrite the card group with 'Overwrite using...'.
6. Click
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7. The cards will now be created. Check the report before clicking
created correctly.

for cards that haven't been printed and/or

Printing a Card without Creating it
Prerequisites:
§ Card Printer connected & configured
§ Card Layout defined

Where
§ Main Menu\Basic\Users

Printing a Card without Creating it
When the User cards already have been created or when 'dummy' cards are printing just to show or sample the layout, the
card can still be printed without writing data on the card.
1.
2.
3.
4.

Select the User(s).
Right click (one of) the user(s).
Pick 'Simple Options > Print User card'.
Pick the desired Layout from the layout menu.

Read more about connecting a Card Printer in the chapter:
How to connect a Card Printer on page:
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Accounts - Tags
Prerequisites:
§ None

Where
§ Main Menu\Basic\Accounts\Tags
§ Side Bar Menu\Accounts\Tags

Accounts / Tags
Tags (in Inepro terminology) are child objects of an Account that have a chip (either pure on the inside, or also visible from
the outside), that cannot store data (for example; the users current balance) and have a unique ID.
Here the tag data can be specified. Cards can only be used in either a combined or Stored Value Card system, just like
tags can only be used in a combined or Store Value Server system. Look up the difference here.
Although a Tag might physically be able to store data, it's still a Tag as long Inepro is concerned as long as there is no
Inepro data stored.

The Account Dialog properties
First screen (User data):

52

-

User Code

Unique number to identify the User.

User

The User linked to this Account.

Account Num ber

The unique number of the account.

Account Group

The group that this card is part of.

Subscription

The subscription of the user.

Status

This field indicates w hether the card has been blocked or not.

Valid From

The start date of the time period the card is valid.

Valid Trough

The end date of the time period the card is valid.
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Second screen (Purses):
The field 'Purse Sub Type' consist of the Purse Type and the Purse Sub Type, for example 'Balance' + 'Personal', where
'Balance is the 'Purse Type', and 'Personal' the 'Purse Sub Type'.
Purse Sub Type

What is the target use of the budget

Purse Type

Is it a balance or a unlimited budget?

Balance

What is the balance?

Purses on the Account

Third screen (tags):
New ID

The tag type; this can be Mifare, a manual code, or any supported tag technology

ID Code

The code that identifies the tag (best not the insert this manually, but automatically by not entering this dialog but presenting
the tag to the administrative terminal).

Passw ord

Passw ord (optional)
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Present a Tag to the Administrative terminal to link a Tag to an Account in this (the tag) screen.

Product groups
Prerequisites:
§ Products

Where
§ Main Menu\Advanced\Product Groups

Product Groups
Product Groups are used to create a more orderly report. If groups are actively used, Products will now be neatly divided in
sub headers on the reports and this will give a better overview.
To create a group simply go to the Edit menu, select the group and click the

Add button.

Product groups can be used to manage the Products and Paper Prices easier.
By default a small number of product groups are provided.
The Product Group properties:
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Nam e

The name of the Product Group

Description

A free field to enter extra information such as a description of the object or it's location.
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VAT
Prerequisites:
§ None

Where
§ Main Menu\Data\VAT

VAT
Fill in the VAT rates that are used in the system. The fields are self-explanatory.
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Products and Paper Prices
Prerequisites:
§
§
§
§

(if used) Product Groups
(if used) Price Lines
(if used) V.A.T.
(if used) created Product Images

§
§
§
§

Main Menu\Basic\Products
Side Bar Menu\Products
Main Menu\Basic\Paper Prices
Side Bar Menu\Paper Prices

Where

Products and Paper Prices
Products are the items that can only be sold by CashPRO devices like candy, soda, etc.
Paper Prices is where prices can be assigned to the products of the DocuPRO device. This can be for example a A4
Colour scan or a B&W A3 print.

The Products / Paper Price properties:
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Im age

An image of the Product.

Product Code

The Product Code is a unique number to identify the product.

Term inal Display
Nam e

A name, less then 15 characters long. This field is stored and optionally displayed on the
PayCon.

Nam e

The full product name (this name w ill be used in reports and in the manager).

Product Group

The group this product is part of.

Price

The product price.

Open Price

Open Price w ill be used w hen the cashier should decide w hat the price of the product is.
For example a 'Soup of the day' could cost €4,00 one day and €5,00 the next. Instead of
setting the price each day the price w ill be open and w ill be set by the employee.

Product Type

The type of the product, for example a 'cash register', 'vending', 'print' or 'copy'. This is used
in combination w ith Device Type and Product Template to make sure the Document products
like 'print' or 'copy' can't be used on CashPRO device like a 'vending machine' and vice
versa.

Link Type

Determines if a product is linked to another product. It can be set to 'Normal' (not linked),
'Compound' (the main product) or 'Linked' a product linked to another product.

Content Type

Determine per w hat quantity type a product is sold (Pieces, Mass or Volume). By default set
to Pieces w ith a Content Factor of '1'.

Content Factor

The multiplier to use w ith the content type.

Tare

Tare is only needed if the product has another content type then 'Pieces'. The Product
container, this can be a bottle, a salad bow l, a plate, a box, etcetera.

V.A.T.

Value Added Tax.

Second V.A.T.

A second Value Added Tax.

Description

An extended description of the product.

Selling

Selling should be ticked if the product is to be sold, uncheck it if it is't.
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Paper Type
(Paper Price Only!)

The job scanner w ill use this paper type to tell DocuPRO manager w hat paper type the job is
using, DocuPRO w ill then inquire w hich printer is sending the job, if it has a product w ith
such a paper type and then charge the price of that product. Never assign the same paper
type tw ice to the same printer!

Description 2

A second extended description of the product.

Description 3

A third extended description of the product.

Description 4

A fourth extended description of the product.

Changed

This is a timestamp (notation of date and time) that is created w hen this record is altered.

Example:
Let us add a 'healthy meal pack'. This is a compound product, it consists of other existing products in the Inepro Back
Office Suite database.

Image
1-7. <Link an existing image, or leave it blank if it's unused>

Product Code
We will have to add all the products that are contained in the compound product, so to keep things clear we will start a
product number range at 1000. So assign the first product, product code 1001.
Product:
1. 1001
2. 1002
3. 1003
4. 1004
5. 1005
6. 1006
7. 1007

Terminal Display Name
The terminal display name is a short name that must be able to fit on the terminal (PayCon, PayMatic, PayCon Touch).
So assign it a name of about 15 characters, depending on the use of smaller or wider letters.
Terminal Display Name:
1. O-jay O. Juice
2. Bread Roll
3. Slice of Ham
4. Slice of Cheese
5. Fruit Yogurt
6. Apple
7. Lunch Pack
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Name
The is the name used on most other locations in the manager and Inepro Back Office Suite, like in the reports.
So a much longer name than at the Terminal Display Name can be used.
Name:
1. O-Jay - Orange Juice 15cl.
2. Bread Roll (Whole Wheat)
3. Slice of Ham
4. Slice of Cheese
5. Yoyoba Fruit Yogurt
6. Apple (Granny Smith)
7. School District Health Lunch Pack 1

Product Group
1-7. <Fill in an existing product group, or leave it blank if unused>

Price
1.
2.
3.
4.
5.
6.
7.

€ 0,
€ 0,
€ 0,
€ 0,
€ 0,
€ 0,
€ 2,

75
85
30
30
40
30
50

Open Price
1-7 Disabled

Product Type
1-7 Cash Register

Link Type
1.
2.
3.
4.
5.
6.
7.

Linked
Linked
Linked
Linked
Linked
Linked
Compound

Content Type
1-7. Pieces
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Content Factor
1-6.
7.

1 (Pieces)
6 (pieces)

Tare
1-7. Not applicable

V.A.T.
1-7. <Fill in an existing V.A.T. rate, or leave it blank if unused>
Second V.A.T.
1-7. <Fill in an existing V.A.T. rate, or leave it blank if unused>

Description
1.
2.
3.
4.
5.
6.
7.

O-Jay
Bread
Ham
Cheese
Yogurt
Apple
Lunch Pack

Selling
1-7 Enabled

Paper Type (Paper Price Only)
1-7 Not applicable

59

Steps

Product Template(s)
Prerequisites:
§ Defined Products

Where
§ Main Menu\Basic\Product Templates
§ Side Bar Menu\Product Templates

Product Templates
Product Templates are named collections of products that can be linked to one or more devices that use these products.
These templates need to have a Device Type, making them only suitable to use for that device. The products on the right
side of the screen can be selected and the single blue left arrow on the bar in the middle can be used to put them into the
template. Use the left blue double arrow to add all products, to remove products from the template use the right arrows.
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The Product Template properties:
Nam e

The name of the Product Template

Device Type

The type of the Device

Description

A free field to enter extra information such as a description of the object or it's location.

Tab Included Products

Choose the products that are needed in this template by either drag-and-dropping them from the product pool
or select them and press the Add Device button. Use the Remove Product button to remove a product,
the Add All button to add all products and finally the Remove All button to remove all the products

Hardware codes
When Products are added to the Product Template,
assign the right hardware code to each product.
The hardware code is the product code in the PayCon
that is used to identify the product.
In a copier, product code '0' can be 'A4 Black and
White' paper and in a vending machine this can be a
'Spiral A1' containing a 'Mars Ice' candy bar.

Adding a Product Template
1) Make sure all the products, that must be added to the group, are available.
2) Go to 'Product Template' and click the
'Add' button.
3) Give the Product template a name.
4) Pick the correct device type for the product group; 'Copier' for a copier, 'Vending' for a vending machine and '
Multifunctional' for a device that can print and copy.
5) Pick product from the product list on the right side and either drag them to the left side or press the
button. (If the
product is not in the list of the right, it must be added first, see 'Add product' on page: ).
6) The terminal must communicate the identity of the product to the device it is linked to, this is done via the 'Hardware ID',
the hardware codes for DocuPRO devices are static and must always be the same. Inquire for the other devices what th
range of hardware codes should be and to which buttons they link to.

PosPRO Templates
The PosPRO template has a lot of extra options that differ from the standard product template.
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Price Lines
Prerequisites:
§ Defined Products

Where
§ Main Menu\Advanced\Price Lines

Price Lines
Price Lines are sets of price deviations on the normal product prices. So for instance a tomato soup is sold at the price of
2.50 in plastic cups at the cafeteria, but it is also sold in a nice sturdy soup cup at a more luxurious location. Or when all of
the sites are connected to one Inepro Back Office Suite database and the prices at different sites must change but cannot
be changed simultaneously. Deviating from the price is possible, making sure still one product is used.
Price lines are optional, not required.
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Adding a price line

1. Press the

'Insert' button to add a new price line.

2. Enter a description and press the
'Normal Price' will remain empty.

'Insert' button to add a price deviation.

3. Press 'OK' and the price line will be added.

Note that the 'Item Price' and the

Note that the 'Item Price' and 'Normal Price' are now visible again.
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The 'Price Lines' are linked to the 'Site Types'. A site must have a 'Site Type', the sites with that site type will then the
appropriate 'Price Line'.
These price lines can be linked to a product and the deviated price in that product price line tab can be set.
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Site Types
Prerequisites:
§ Defined Price Lines

Where
§ Main Menu\Advanced\Site Types

Site Types
Site type are used in combination with 'Price Lines'. Give a site a typ that would define if and what kind of price deviation is
needed on that site.

The name should be a description of the site in respect to the price line.
When using different price lines, different site types must be defined.
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How to use the Organisation structure
Prerequisites:
§ Defined Price Lines

Where
§ Main Menu\Advanced\Organisation

How to use the Organisation structure
Every instance of the Inepro Back Office Manager needs a site defined. A site can be part of a location, and a location can
be part of a organisation. When the Inepro Back Office manager is started for the first time, or when the setup wizard is
started or when either the 'Organisation', 'Location' or 'Site' option is chosen directly the organisational structure can be
adapted.

Some samples of an organisational structure:
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Example 1

Example 2

Organisation

Inepro group

University of Knowledge

Location

Germany
The Netherlands
United Kingdom

City Centre Harbour

Site

Berlin_1
Berlin_2
Cologne

Department of physics
Department of mathematics
Accounting Management
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To add a complete organisation keep in mind the organisation can be separated in a maximum of three groups,
Organisation, Location and Site.

Organisation
Prerequisites:
§ None

Where
§ Main Menu\Advanced\Organisations

Organisation
Organisation is the top group of the hierarchical structure of an organisation such as a national department (like Inepro
Holland, MacDonald's Holland or Microsoft Holland). It is the top level group that can be used to group by in the reports. An
Organisation can have one or more Locations, which in turn can have Sites.
Go to menu Edit --> Organisation:

Press the Add button

to open the new / insert menu:

Fill out the name of the organisation.
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Location
Prerequisites:
§ Defined Organisation

Where
§ Main Menu\Advanced\Locations

Location:
Location is the middle group of the hierarchical structure of an organisation, and it can be part of an Organisation and can
have one or more sites. Location will be used for the middle group for an International firm this could be Amsterdam, or
London for a small firm or school this could be 1st Floor, 2nd Floor or Sales Department, Support, Administration etcetera.
This is the second group to group by.
Go to menu Edit --> Location:

Press the Add button

to open the new / insert menu:

Fill out the location name and the organisation. The location name can be a city but it may also be an area or any other
name. The idea is to group the data by location.
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Site
Prerequisites:
§ Defined Location
§ (Only if Price Lines are used) Site Types

Where
§ Main Menu\Advanced\Site

Site
Within Location is the final group Site. Site is the place where a device, user or PayCon is physically located. It is the
smallest group of the hierarchical structure of an organisation and it is mandatory. This group is needed. That is why it is
required to fill out a site when the software is started for the first time.
Site can be 'Amsterdam - Kalverstraat' or 'New York City - Times Square' but it can also be Room 205 or Administration, it
all depends on how the organisational structure within the Inepro Back Office suite has been planned.
Go to menu Edit --> Site:

Press the Add button

to open the new / insert menu:
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Fill out the location name and the organisation and the site data. The site can be an office, a department or even a floor or
part of a building. It is the smallest group the data can be grouped by. Make sure to fill out the Site Type (it can be set to
default when price lines are not used) and the Code (which must be a unique numeric value).

DocuPRO Device(s)
Prerequisites:
§ DocuPRO hardware

Where
§ Main Menu\Basic\DocuPRO Device(s)

DocuPRO Devices
DocuPRO devices are copiers, multi-functional's and printers.
Printers are automatically imported. When the printer is installed in Windows it will be imported as DocuPRO device.
Copier need to be added manually. Multi-functional's are created by adding the device as a Windows printer (letting the
device be imported as DocuPRO device), then adding a copier and merging them into one device.

The DocuPRO device properties:
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Short Nam e

Enter a name for this device no longer then 15 characters, this is used for display on the terminals.

Long Nam e

Enter a name for this device no longer then 40 characters, this is used for reports.

Address

The IP-address of the device.

Device Type

The Device Type is a type of device like a 'printer' or 'cash register'.

Product
Tem plate

Product Template is a pre-set list of Products or Paper Prices w ith certain settings already configured. Manually configure large
groups of products at once.

Site

The site the user, device, product or PayCon is located.

Description

A free field to enter extra information such as a description of the object or it's location.
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CashPRO Device(s)
Prerequisites:
§ Sites Defined
§ PosPRO Hardware (like a PosPRO till) installed and connected to the network

Where
§ Main Menu\Basic\CashPRO Device(s)

CashPRO Devices
CashPRO devices the devices that make money exchanges within the Inepro Back Office Suite. For example the vending
machines, MPV's, reloaders, PosPRO cash register (or till), and PayCon cash registers.
1) Go to 'CashPRO Devices' and click the
'Add' button.
2) Fill in the long and the short name
3) Set the 'Device Type' to a device according to the table below.
Device Type
-

Description

Cash Register

A PayCon cash register

MPV

A Multi Purpose Vending machine

Reloader

A car or account loader

PosPRO
A PosPRO cash register
Vending Machine A simple vending machine

Default Project Tem plate(s)
Cash Register, No Products
Keyboard, 64 keys
Keyboard, 128 keys
MPV, No Products
Generic Kiosk Reloader
Default Reloader
PosPRO, No Products
<None>

4) 'Product Template' to one of the template available for this device.
5) The site should be set to the location of the device.
6) The description and address fields can be left open or set to the precise location in the address field and the extended
description of the device can be given in the description field.
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Printer Rule Sets
Prerequisites:
§ DocuPRO hardware
§ DocuPRO

Where
§ Main Menu\Advanced\Printer Rule Sets

Printer Rule Sets
Printer Rule Sets allows a set of rules to be entered so it can be attached to a printer. The rules can determine what must
be done with certain print jobs. For example big print jobs could be led to a specific printer that is meant for such jobs even
if the user sends it to another printer. Or it could prevent a certain department from printing in colour. There are a lot of
possibilities.
First a set must be created, given an unique name and then the rules belonging to that set must be added.

The options of the new printer rule window are explained in these tables:
Printer Rule Type
Delete job
Do not charge
Pause job
Redirect
Redirect & Reprice

Delete any jobs that this rule applies to
Do not charge anything to the job ow ners car or account
Pause this job
Redirect this job to another printer
Redirect this job to another printer and change its price

Printer Rule Confirm Type
Acknow ledge w ill show s a message w ith an 'OK' button. The action can
Acknow ledge not be stopped. The user w ill confirm that he has seen the message, and
the action w ill be executed.
Acknow ledge or Decline w ill show a message w ith an 'OK' and 'Cancel'
Acknow ledge
button. The user can stop the action by pressing 'Cancel'. The job w ill then
or Decline
not be printed.
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Notify
Silent

Operator
<>
=
<
<=
>
>=

Notify w ill show the user a message notifying him of the applied rule. In the
mean w hile the action is executed.
No message is show n to the user. The user is not informed about the
applied rule.

The job properties
The job properties
The job properties
The job properties
The job properties
The job properties

Properties
Pages
Spool file Size (kb)
Paper Size Type
Color
Duplex
Document Name

Other
Department
Description
Custom Message

are greater then or smaller then the follow ing properties
are equal to the follow ing properties
are smaller then the follow ing properties
are smaller then or equal to the follow ing properties
are greater then the follow ing properties
are greater then or equal to the follow ing properties

The number of pages in the job
The size of the spool file (in kilobytes)
The size of the paper (A4, letter, ledger, envelope No.10)
Is it a colour job? (Don't care, true or false)
Is it a duplex (tw o-sided) job? (Don't care, true or false)
The name of the document printed

The rule only applies to this department
The description of this rule (Use this to describe in the manager
w hat this rule is supposed to do)
Show this message to the user depending on the confirm type (it
w on't be show n if the confirm type is set to silent)

It should now be possible to create all kinds of sets that will govern the flow of the print jobs.
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Printer Pool(s)
Prerequisites:
§ Printer Rules (Only if used)

Where
§ Main Menu\Advanced\Printer Pools

Printer Pool(s)
A Printer Pool within the Inepro Back Office Suite is a collection of printers that can use follow-me. That is if one printer in
the pool is busy, broken or for any other reason not the first choice to print at, the job can be collected by another printer in
that pool.
While a printer pool can exist over more than one server on multiple sites, the follow-me functionality cannot. So it only
possible to print out the job at the printers in the printer pool at the local print server.
The printers in the pool are ideally all the same brand and type. But this is not required. It is best to use at least use
printers of the same brand with the same support for Postscript and / or PCL.
In order to manage the follow-me functionality organize the printers / Multi Functional Devices (MFD's) in follow-me or
printer pools. These pools can be freely defined, for example:

Printer pool A:
A black & white printer without follow-me
possibilities
Printer pool B:
2 black & white printers with follow-me enabled
Printer pool C:
3 colour printers with follow-me enabled

So a user printing to Printer Pool 'C' on the server on the site on the left side will only be able to print on the two printers in
the pool on the left side. And a user printing to Printer Pool 'C' on the server on the site on the right side will only be able to
print on the only printer available on the right side and will have no follow-me functionality.

The Printer Pool properties:
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Nam e

The name of the printer pool

Printer Rule Set

The set of printer rules linked to this pool

IBOS CashPRO

Define

Description

A longer description of the Printer Pool

Printer Rule Sets

When a Printer Rule Set has been created that set can be added here to apply to all the printers in the pool.

Link the Printer to a Printer Pool

The area below w ill show all the devices in the printer pool.
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Go to the printer or m ultifunctional in the DocuPRO devices and link the printer pool to the printer.
An additional Printer Rule set m ay be added.

When retuning to the Printer Pool w indow , the printer in the area below is show n.

Configuring the printer will treated in this section:
Configure Printers on page: .

76

-

IBOS CashPRO

Define

Regional Settings
Prerequisites:
§ None

Where
§ Main Menu\Tools\Regional Settings

Regional Settings
The settings in these Windows are self-explanatory. Just set them to the local settings and values.
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Page
Numbers
Currency
Time
Date
Months
Week Days
Language

Description
Number Punctuation (Decimal symbol, grouping symbol, list separator)
Currency settings (Decimal settings, Currency symbol, etc.)
Time settings (Time separator, etc.)
Date Settings (Tw o-year digits, short & long dat settings)
Month names
Week day names
Language choice

Card / Account Settings
Prerequisites:
§ None

Where
§ Main Menu\Tools\Card / Account Settings

Card / Account Settings
With Card / Account settings the system can be set as Stored Value Server system, keeping the money on the server, as
Stored Value Card, keeping the money on the user card, or to have a combined system, combining SVS and SVC.

When to use the Stored Value Server Environment
When a system is set up for a 'Stored Value Server Environment' all relevant balance and account information is stored on
the server.
This means the user only needs a way to point to this account information.
This can be done with a wide variety of possibilities: PIN-codes, cards (ID-only) …

Some of the advantages are:
· Because the system only needs an ID to recognize the user a wider number of cards can be used, including PIN code

identification
· No need to write data on an existing customer card
· Accounts can be credited without the user and or card present

Supported technologies:
·
·
·
·
·
·
·
·
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Contact chip card
Magnetic stripe card
Mifare proximity card
Legic proximity card
Hitag proximity card
Barcode card
Proximity card
...
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When to use the Stored Value Card Environment
When a system is set up for a 'Stored Value Card Environment' all relevant balance and account information is stored on
the user's card. This is comparable to the electronic purses the banks offer in various countries.

Some of the advantages are:
·
·
·

Each user takes more care of his card because his money is on this card
Can be used with non-networked payment systems
Even if the network is down a large number of transactions still can be done

Supported technologies:
·
·

Contact chip card
Mifare proximity card

Departments
Prerequisites:
§ (Only if they are assigned here) defined Cost Centre(s)

Where
§ Main Menu\Advanced\Departments

Departments
A Department in Inepro Back Office Suite is used as a User group to book their costs to a Cost Centre.
Go to Edit --> Department:
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Press the Add button
to open the new / insert / add menu:
Fill out the long and short name of the Department.
Cost Centres can be added and must be linked to this Department in the submenu 'Cost Centres'

Function Limitation Settings
These settings will overwrite the settings of the multifunctional enabling or disabling settings for a certain department. So
even if the settings are disabled in the multifunctional, they will be enabled if these settings are set to true.
This function is only available for the embedded API terminals!

80

-

IBOS CashPRO

Define

Device Groups
Prerequisites:
§ (Only if the devices are added here rather then assigning Device Groups to Devices) Defined Devices

Where
§ Main Menu\Advanced\Device Groups

Device groups
The Device Group is used to create a more orderly report. If groups are actively used the Devices are seen neatly divided in
sub headers on the reports and this will give a better overview.
Choose a name for the group and enter it. To complete this select the Device Type and the Devices in that group and press
OK.

The Device Group properties:
Nam e

The name of the Device Group

Device Group Type

The type of the Group

Description

A free field to enter extra information such as a description of the object or it's location.

Tab Included Devices

Choose the devices that are needed in this group by either drag-and-dropping them from the device pool or
select them and press the Add Device button. Use the Remove Device button to remove a device, the
Add All button to add all devices and finally the Remove All button to remove all the devices

81

Steps

Card Layout(s)
Prerequisites:
§ (if the layout is to be used) A Card Printer
§ (if the layout is to be used) A Card Printer Licence
§ User data, like name, photos, bar codes, etcetera present in the database to test the layout

Where
§ Main Menu\Advanced\Card Layouts

Card Layout
In Card Layout the layout of the user cards or tags can be created or edited.

Creating a new Card Layout
§ Decide which information must be printed on the card, maybe the class a student is in on the card, or their gender,

birthdate, barcode or address information.
§ If more user specific information on the card than we provide room for in the database is needed, we recommend

'misusing' the fields 'Address Line 2' and 'Address Line 3' if they are not (and will not be) used by the system otherwise.
Import the correct information with either CSV or Active Directory see page:

§ Go to 'Advanced -> Card Layouts'
§ Click 'Add new Card Layout'.
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Worksheet
§ Enter a name and click 'Adjust Layout'

§ In general it's easier to start from scratch than to adapt the default layout, but if a chip card layout must be created, leave

the golden square that represents the chip card for position purposes. In all other cases follow the steps below:
§ Click on the workspace and select all objects (CTRL-A).
§ Delete all the objects (Press <Delete>)

Background Picture
§ If a background picture is used make it as big as the background (Right-click => 'position', 85700 width and 53900 high,

left and top 0) Select the 'image' icon.
§ Check Stretch in the properties to ensure the whole area is covered.
§ With the property 'Picture' the image file can be imported into the layout.
§ I choose 'Desert Landscape' from the Windows Vista Example Image map or 'Water lilies' from the Windows XP image

example map.

83

Steps

Database and non-database text
§
§
§
§

Now we will add the User Number on the card.
Select 'DBText', this is a database sensitive text.
Set the font to 'Arial' en font size to '12'.
Set 'Transparent' to 'enabled' to let the background show, and to 'disabled' to create a fixed colour backdrop. We will
disable this as the water lily image is too distracting.
§ On the lower right the properties of the object that is selected are shown.
§ Set the 'Datafield' to 'Customer Code' (remember each data component must be linked to the database like this (via data
field)).
§ Create a label. It now has the same font and size as the 'DBText' object. Set the label text to 'Customer code:' and place
it before de DBText.
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Database image
§ Select a DBImage. Set the width to '20000' and the hight to '30000' (Right-click => 'position'), as this will give the 2x3

ratio for pictures. Make sure to check Stretch to ensure the picture won't fill more then the area assigned to it, and check
'MaintainAspectRatio' to ensure it get stretched out of proportions.
§ Set the 'Datafield' to 'Photo'.

Multiple database texts inline
§ When displaying more then one dynamic DB object neatly next to each other on the same height there will be a problem,

it is unknown what the width of each object will be and if they will overlap. For this issue there is a trick.
Select a RichText object (so, not a DBRichText object), right-click it and click 'Edit'.
The Rich Text Editor Window will open.
In the top left, the Mail Merge checkbox can be found, check it and select the pPipeLineTender data source.
Select the fields 'Gender', FirstName', Infix', LastName'.
In the screen
'<dbtext>Gender</dbtext><dbtext>FirstName</dbtext><dbtext>Infix</dbtext><dbtext>LastName</dbtext>' appears,
click on the workspace and place spaces between the XML tags and add labels, like this: "Gender:
<dbtext>Gender</dbtext> Name: <dbtext>FirstName</dbtext>.
§ So now these fields will stay apart, but will also form one uniform line of text without having more space between the text
on one card and less one another.
§ Close the window and answer 'Yes' when asked to save the changes.
§
§
§
§
§

Gender
§ Now the Gender field in the database is a number, '0' for unknown, '1' for male and '2' for female. To create a more elegant

presentation just look at "Import the correct information with either CSV or Active Directory", see page: to import a
written gender code to an unused column in the user table.
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Birth Date
§ For the birth date that we'll place under the photo, other data can also be added using the fields 'Address Line 2' and

'Address Line 3' if they are not used (and will not be in the future) by the system otherwise. Just look at the CSV import
work example.

Bar code
§ A bar code can easily be created, and can be linked to either the bar code field (the best way) or directly to the user

code field. Some bar codes (like codabar) need a letter as first and/or last character, if this is not available in the user
code, the proper formatted bar codes must be created and imported in the bar code field in the database. See Import the
correct information with either CSV or Active Directory", see page:
§ Set the 'Datafield' to 'Bar Code' (remember each data component must be linked to the database like this (via data field)).
§ Select the bar code type.

Save the design
§ Close the designer, it will not be asked to save the progress but don't worry, this is done in the Layout window.
§ Give the layout a name and press 'OK'.
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Subscription Layout(s)
Prerequisites:
§ (if the layout is to be used) A Subscription Printer
§ (if the layout is to be used) A Card Printer Licence

Where
§ Main Menu\Advanced\Site Types

A Subscription Layout
See Define - A Card Layout
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Cost Centres
Prerequisites:
§ (Only if Departments will be assigned here) defined Department(s)

Where
§ Main Menu\Advanced\Cost Centre

Cost Centres
A Cost Centre is the location where, in bookkeeping, the costs of a product are being made. Users can book their costs on
this Cost Centre. They can either do this directly or via their department.
To let a group of users book their costs on one or more Cost Centres a department must be created.
Cost centres are needed if the costs of a user must be kept completely separated for instance: business groups, lunch,
copying, multiple business cases, etc..
Go to Edit --> Cost Centre:
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Press the Add button

to open the new / insert / add menu:

The cost centre code is a alphanumeric code that is assigned to a Cost Centre. Also fill out the long and short name of the
Cost Centre and the description.

Maximum Spending Amount
The maximum spending amount is the total amount that can be booked on a Cost Centre.

Amount Spend
The amount spend field will show how many money has been booked on the cost centre.

Reset amount spend
Use this button to set the 'amount spend' value back to zero. Typically this should be activated by the manager when the
cost centre is reimbursed with the monthly amount.
Warning: If the maximum amount has been reached, no more cost can be booked on this cost centre until the amount
will be reset.
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Product Tare
Prerequisites:
§ None

Where
§ Main Menu\Advanced\Product Tare

Product Tare
Product Tare is used in the situation, where the customers to return the container in which the consumer goods are
preserved. Like a luxury salad bowl with a salad that is priced per weight or a glass bottle of Coca Cola.
Or if the ink usage must be calculated in great detail, the software wil calculate the ink and the final product will be the
copy (A4 colour) + the price of the used black, cyan, magenta and yellow ink units.
With these products the product itself would be sold (in example the Cola) and the container (the bottle) will be returned.
This menu is where the details of such a container are specified.
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Ink

The ink used to print a page calculated in units of 1 pro mille
of an A4 page.

Pieces

The number of pieces.

Tim e

The time in seconds.

Volum e

The volume of the container in litres.

Weight

The w eight of the container that is sold w ith the actual
product. (ie. the glass salad bow l) in gram

Define

Card / Account groups
Prerequisites:
§ A Card Layout

Where
§ Main Menu\Advanced\Card / Account Groups

Card / Account Groups
The Card Groups are used to create a more orderly report. If groups are actively used the Cards will be neatly divided in sub
headers on the reports and this will give a better overview.
To create a group simply go to the Edit menu, select the group and click the

Add button.

Choice a name for the group and enter it. In case of the device group the Device Type and the Devices in that group must
be selected.
The Card / Account Group properties:
Card / Account Group ID

A unique code to identify this object.

Short Nam e

A name, less then 15 characters long. This field is stored and optionally displayed
on the PayCon.

Long Nam e

A long name (40 characters) is the name used in our Window s applications and
the receipt in the PayCon, every other time short name is used.

Tender Layout

The card layout for this group

Default Subscription

The default subscription

Included purses

The purses for this group

Changed

This is a timestamp (notation of date and time) that is created the moment this table
is altered.
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Customer Groups
Prerequisites:
§ None

Where
§ Main Menu\Advanced\Customer Groups

User Groups

To create a new User group just click
and enter a name that identifies the group.
Using User groups will enable the software to give an entire group (that consist of multiple departments and/or cost centres
or has other reasons to not fit in those two groups) certain rights.
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AccessPRO Zones
Prerequisites:
§ None

Where
§ Main Menu\Advanced\Site Types

AccessPRO Zones
An area that has access controlled doors by AccessPRO is called a AccessPRO zone. Each zone has at least one door,
each door has two sides. Each door side should have a AccessPRO Device connected to it. To enter a zone a door must
be opened or an access portal must be crossed.

Define zones
A user zone can be defined by clicking 'Edit' -> 'Access Zones'.
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For example to enter zone 'K' door 1 must be
opened on the A side, zone 'A' must be entered
and then door 15 on the 'A' side must be opened.
Additionally doors 1a and 15a must be opened to
get in, 15b and 1b to get out.
Of course another path can be taken; open door
20 on the 'A' side, enter zone 'B', open door 21 on
the 'B' side, enter zone 'A', open door 7 on the 'A'
side, enter zone 'I', open door 9 on the 'A' side and
finally enter zone 'K' but that would be taking a very
inefficient route.
Doors on the outside of a building and the zones
connected to these doors are entered as 'root
nodes' in the tree structure in Inepro Back Office.
Zones that are accessible exclusively by another
zone have that zone as a parent in the tree
structure.
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Zone A
Zone A lies directly next to the outside world, so enter 'Zone A' as name and select 'Outside World' as parent node.

Zone B
Zone B lies directly next to the outside world, so enter 'Zone B' as name and select 'Outside World' as parent node.

Zone I
Zone I lies directly next to Zone A, so enter 'Zone I' as name and select 'Zone A' as parent node.

Zone K
Zone K lies directly next to Zone A, so enter 'Zone K' as name and select 'Zone A' as parent node.
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AccessPRO Devices
Prerequisites:
§ AccessPRO Zones defined
§ AccessPRO Groups defined (Only if used)

Where
§ Main Menu\Advanced\Site Types

AccessPRO Devices
An AccessPRO Device is a terminal that will validate a user and according to that validation allow or deny a user access to
an AccessPRO zone.
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Field

Description

Short Name

A name, less then 15 characters long. This field is stored and optionally displayed on the PayCon.

Long Name

The full AccessPRO Device name (this name w ill be used in reports and in the manager).

Address

This field can be used to specify the exact location of the device.

Device Type

(Is alw ays AccessControl)

Site

The site that this device is located.

Description

This field can be used for additional information.

Anti-Pass Back
Enabled

Is Anti-Pass Back enabled? Anti-pass back w ill prevent the possibility of a user entering a zone he or she is already in.
Thus preventing a user to pass his or her pass to another user.

Dashboard ID

The ID of the AccessPRO Dashboard application this device is linked to.

Groups

The AccessPRO groups connected to this device.

Terminals

The terminal that controls the door and validates the user.

Access Zones

To w hich zone this device is in. So a door betw een Zone A and B w ill have tw o devices, one in zone A - giving access
to zone B, and one in zone B - giving access to zone A. This field should be filled w ith the zone the device (card reader)
is in.
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Defining AccessPRO Devices
We will add the doors needed in the example in the AccessPRO Zones section.

Door 07 - A
Name the device 'Door 07 - A', add the site, enable anti-pass back, and link to AccessPRO Zone A, and correctly set the
terminal and AccessPRO user groups to this door.

Door 07 - B
Link this to Zone I.

Door 09 - A
Link this to Zone I.

Door 09 - B
Link this to Zone K.

Door 15 - A
Link this to Zone A.

Door 15 - B
Link this to Zone K.

Door 20 - A
Link this to the outside world.

Door 20 - B
Link this to Zone B.

Door 21 - A
Link this to Zone A.

Door 21 - B
Link this to Zone B.
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Access Rules
Prerequisites:
§
§
§
§
§

AccessPRO
Users
User Groups (if making rules based on groups of users)
AccessPRO zones
AccessPRO devices connected

Where
§ Main Menu\Advanced\Site Types

Access Rules
A rule that grant or denies a user (or user group), access to a certain device (or Zone) for an infinite or limited period of
time. It can also determine if the user (or user group) has access when the device (or Zone) is offline.
The Access Rule properties:
All Zones

The rule w ill apply to all zones

Access Zone

Specify the zone the rule w ill apply to

Grant Access to

Who w ill have the right to access? It can be a user, User group or department

Periodical Access

When w ill the access be granted? It can be a period or a time-frame in certain w eek days

Has Access

Determine if the access w ill be granted or denied

Offline

Determine if the rule w ill apply if the Access Device is offline
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Reasons
Prerequisites:
§ None

Where
§ Main Menu\Advanced\Site Types

Reasons
The reasons must be given when revaluing or devaluing a card or account, applying a discount, reimbursing returned goods
or when a user is reporting himself absent. The valid reasons for these actions can be declared here.
When creating a new valid reason the reason type must first be set, these are explained in the table below:

Absence
Deduct
Discount
General
Reload
Return

Reason Type
Reason Code
Description
External ID
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Reason Types
This reason is one of the possible reasons to be absent from
w ork or school in the used absent system
Money is directly taken from the account or card via the Inepro
Back Office Manger. This reason w ill describe w hy.
The reason that the user has received this discount
All other events
Money is directly added to the account or card via the Inepro Back
Office Manger. This reason w ill describe w hy.
The user returns a product or denies a service and w ants his
money back. This reason w ill describe w hy.

Reason
One of the Reason Types as described in the table above
An arbitrary code assigned by the employee to identify the
reason.
A description of the reason.
Absence Reason are often taken from an external absence
system, this ID should be the same as the ID in the external
system and may be used to synchronise betw een the tw o
systems.

Define

Budgets
Prerequisites:
§ Products or Product Groups defined

or
§ Users, User Groups or Departments defined

Where
§ Main Menu\Advanced\Site Types

Budgets
Budgets in the Inepro Back Office Suite are used to define limitations to how many items of a Product or Product Group
can be used or what amount might be spend on that Product or Product Group by a User, User Group or Department.

Product

The Product that is restricted.
The Product Group that is
Product Group
restricted.
The User to w hich the budget
User
applies.
The User Group to w hich the
User Group
budget applies.
The Department to w hich the
Departm ent
budget applies.
How many products may be
Quantity
bought by the department,
group or user.
Budget Am ount
The amount that may be spent.
The period that the budget
Period Selection
applies to, after w hich it resets.
The time at w hich the budget is
- Daily - Start Tim e
valid.
The time at w hich the budget is
- Daily - End Tim e
no longer valid.
The w eekday the budget is
- Weekly - Start Day
valid from.
The w eekday the budget is
- Weekly - End Day
valid through.
The day number of the month
- Monthly - Start Day
that the budget is valid from.
The day number of the month
- Monthly - End Day
that the budget is valid through.
Description
A description of the budget.
The start date the budget is
Valid From
valid from.
The end date the budget is valid
Valid To
through.

Warning: Budgets can only be used for the PosPRO till and it's products.
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Example
The students may only buy one snack per day.

Product Group:
Snacks

User Group:
Students

Quantity:
1

Budget Amount:
<blank>

Period Selection:
Daily

Start Time:
00:00 (unlimited)
End Time:
00:00 (unlimited)
The description and valid field may be left blank.

User Interface
In the user interface the toolbars, divider bars and a detail screen are available. Each option is easily recognisable by the
use of icons.

Toolbars
A toolbar is a collection of buttons on a bar. These buttons can be used to perform the most frequently used actions within
our software.
Read more about Toolbars in the chapter:
Toolbars on page:
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Detail Panel
The Detail Panel is a panel that shows the details of the current object. For instance if the object Users is active, the
details of that user are seen in the detail screen on the right side of the screen. At the bottom one or more tabs are visible
with detailed information about the current record, click each tab to examine all the specific information about this User (or
device, account, etcetera).
Adding, Editing or Deleting anything in the Detail Panel is not possible!

Divider bars
The divider bars are used to divide different parts of the detail screen. Use them to hide certain parts or to make those
area's bigger or smaller.
Read more about the Detail Panel and the Divider Bars in the chapter:
Detail Panel and the Divider Bars on page:

Context Menu
The context menu is a menu that will show options that are relevant to the active object in the program.

In the context menu the options are also available on the toolbar and links to other parts of the program:

Go To...
This is a shortcut to another relevant part in the software.

Session Log
This log will contain all transactions that were made in a session. A session is started when the card is inserted and ends
when the card is removed. Even 'Card Inserted' and 'Card Removed' are logged as transactions. The data can be filtered.
A session log does not have to contain one user. A user could go to a vending machine, try to purchase a product and
walk away to complain when the product can not be delivered. Another user can then purchase a higher priced product and
pay for it with partly his and partly the other user's money. This will not be a session nested in a session but count as one
session (it will end when the first user presents his card to the PayCon). The money from the first user would have
'disappeared'. The administrator can track the money and the user who took it via this session log.
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How to work with the Toolbars
We have made a chapter for each toolbar:
Navigation

to navigate through the records

Modify

to modify the data

Refresh & Filter

to refresh and filter the data

Table Properties

to alter the properties of the table

Run & Print

to run a Device Log request and to print data

Export to Excel

to export data to Microsoft Excel

How to use the Navigation Bar
This is the navigation bar:
Use the bar to navigate through the records in a table for instance all the users in the users table.
It has 6 buttons, First Record, Window Top, Previous Record, Next Record, Window Bottom, Last Record.

First Record
Use this button to go to the very first record, the first set of data in this range

Window Top
Use this button to go to the top, complete visible record in the window

Previous Record
Use this button to go to the previous record

Next Record
Use this button to go to the next record

Window Bottom
Use this button to go to the bottom, complete visible record in the window

Last Record
Use this button to go to the very last record, the last set of data in this range
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How to use the Refresh & Filter Bar
This is the Refresh & Filter Bar:
This bar is used to Refresh the data from the database to make sure the latest data is available or to build a custom filter.

Refresh
Use this button when data objects (could) have been added to the database while DocuPRO has been opened to ensure
the latest data is available. For example the information of some printers or Terminals could have been added to the
database while the manager has already been active for a while. Or the history of users or devices could have been
changed. Click 'refresh' to show the latest data.

Build Filter
Use this button to build a custom filter. It will open the build filter screen shown below in which a filter can be build, saved to
the disk, or load one that is saved earlier.

Read more about building advanced filters in the chapter:
How to build an advanced filter on page:

How to use the Modify Bar
This is the Modify Bar:

The Modify Bar can look different!
When possible the icons are a representation of the active object.
For instance below are the modify bars for 'Users' , 'Cards' and 'Product Templates'.
Users
Cards
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Product Templates

As can be seen the plus

, exclamation mark

and x

symbol are shown at their respective icons.

This bar is used to modify data in the database. New records can be added, edited and/or deleted. To modify use the 3
buttons on the Modify Bar: Add , Edit
and Delete .
If this bar is shown in the detail screen of another object, data in that detail screen can be Inserted, Edited or Deleted.

Add new data
Add / insert / new.
Add a new object, this can be a new user, a new card, a new device or any other data object in Inepro Back Office
Manager. After adding the new object, fill out the data required, for example, the name and department number of a new
user.

Edit existing data
Edit data that already exists. Use this to for instance to edit the address of a user (in users), the name of a device (in
devices) or the status of a card (in cards).

Delete data
Delete a data object. Use this to delete a data object from the database. Confirmation will be asked in a dialog, make sure
the data can really be deleted!

106

-

IBOS CashPRO

User Interface

How to use the Table Properties Bar
This is the Table Properties Bar:
This toolbar is used to select the data fields to view and to make the field spaces as efficient as possible.

Fields

Use this button to select which data
fields to view, their widths and the
order they should appear.

Apply Best Fit (Set column spacing)
Use this button to automatically set the width of all columns to the smallest possible width while displaying the complete
value and header text. This will often mean that the column width will be made wider in stead of being made smaller.

How to use the Run & Print Bar
This is the Run & Print Bar:
Use this toolbar to run the selected query in 'Device Log' and 'User Log' to print out the results.

Run
Use this button to run the query in 'Device Log' or in 'User Log'. The history of the selected device or selected user in the
selected time frame will be shown.

Print
Use this button to print the result of the query in 'Device Log' or in 'User Log'. The history of the selected device or selected
user in the selected time frame will be printed. In a preview screen the print order can be confimed.
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How to use the Export To Bar
This is the Export To Bar:
This bar is used to export the data to Microsoft Excel

Export To Excel
Use this to save the data as an Microsoft Excel file. A save dialog screen will appear and choose the save location.

How to group data and build filters
The data in the Inepro Back Office Suite is presented in a data grid, a matrix of cells not unlike Microsoft Excel in which the
data is presented. In some cases the data can be sorted, grouped or filtered.
Filter needs need to be as flexible as possible.
That is why we provided a drag-and-drop tool to group the data and use an easy tool to create custom filters.

How to Group data
Data can grouped directly in the screen.
This example will show how to group data using the grey 'Group By' bar. We will use the
First drag and drop 'price' to the grey space below the toolbar as shown in this image:
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'Paper Price' table.

User Interface

The table is now grouped by the values in the field [price]. Each value can be expanded by clicking the plus [+], or
collapsed by clicking the minus [-]. Note that the value '0,05' has been expanded and that the [Product Types] are 'Print' or
'Copy' and the [Product Groups] are 'Print', 'Copy' or 'special'.
Now drag and drop [Product Type] to the grey 'Group By' bar.

As seen the price '0,05' has been further divided into the [Product Types]: 'Copy' and 'Print'.
Refine the view one more time by dragging [Product Group] into the 'Group By' bar.

Now the view is as detailed as possible, the [Product Type]: 'Copy' has been further divided into 'Copy' and 'Special' while
the [Product Type]: 'Print' has only one group: 'Print'.
Such detailed grouping as often not necessary but if so many levels below the one in this example are available.
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How to build an advanced filter
If viewing a selection of the data in the database, a filter is often needed.
With a filter, decide which data is not needed and filter it out.
In this example the

'Paper Prices' table is used.

To build a filter press the Build Filter button

, this screen will pop up:

Click on 'press the button to add a new condition'.
Click on the field name to select another.
We have chosen 'Product Code'.

Set the operator to 'like' and the condition to '%8%'.
Like '%8%' means search for everything with an 8 in the
string.
The % is a wildcard.

The view shows three product codes: '08', '20060306152528' and '20060306152809' which all have an '8'.
Below the filter bar to indicate a filter is used can be seen. The column(s) that the filter applies to has a blue arrow in stead
of a black arrow.

Notice that the product group has to different values 'special' and 'Print'.

110

-

IBOS CashPRO

User Interface

Add a new condition by clicking on 'press the button to
add a new condition'.
Set the field to
'Product Group', the operator to 'equals'
and the condition to 'special'
Click 'OK'

Now only two records are shown, those who have the value 'special' in

'Product Group'.

To save the filter click 'Customize' on the filter bar and click the 'Save As...' button.

Load a filter in the same menu.

Context Menu
Context Menu
The context menu is a menu that will provide the options that are relevant to the current object in the program.

Detail Panel and Divider Bars

111

Steps

Image 1
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Image 3

Configure System Settings

Configure System Settings
Prerequisites:
§ None

Where
§ Main Menu\Tools\System Settings

Configure System Settings
The system setting are set with the installation of the software, they contain database catalog names and other systemwide behaviour settings. The settings can be restricted to either global or per server.

Use setting global or per server
Server setting can be used per server or globally. To use setting globally, leave the selected server to 'not assigned', to use
a setting for a specific server, first select that server.

In the settings edit dialog, use the 'Global Value' for all the unspecified servers on the network or to the server value, which
edits the setting for the selected the selected server.
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AbsencePRO
Prerequisites:
§ AbsencePRO hardware installed
§ AbsencePRO devices connected with IBOS.

Where
§ Main Menu\Tools\System Settings\AbsencePRO

AbsencePRO
AbsencePRO is the software component of the Inepro Back Office Suite which handles the data entered when a user
registers his or herself as being 'too late'. Often this data is also needed by a third-party software suite. The database
connection setting for such a suite can be set here. The data that is first send to the Inepro Back Office Suite will then also
be send to the third-party suite.

Catalog

Third party database name (MS SQL catalog)

Data Source

Third party database server URI of the data source (like: '.', local or '\\MySQLserver\SQLEXPRESS').

Passw ord

Third party database passw ord

Usernam e

Third party database username

Make a connection with third-party software
To make a connection with third-party software a software consult by Inepro is needed. At this moment Simac Onderwijs's
@VO is supported, other connections must be evaluated by Inepro before they might be supported. Please contact the
Inepro account manager assigned to your organisation in this case.
If @VO is used, please fill out the required data for the @VO database as described above.
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DocuPRO
Prerequisites:
§ DocuPRO hardware installed
§ DocuPRO devices connected with IBOS.

Where
§ Main Menu\Tools\System Settings\DocuPRO

DocuPRO
DocuPRO is the software component of the Inepro Back Office Suite which governs the behaviour of the DocuPRO module.
How print jobs are released, if and when they are purged, if job codes and the client are used, and how the customer
interface of the client is set up.

Printer Ignore List
Key
Monitors

Ports
Processors

Value
AdobePDF.dll, PCOUNTAS.dll, PCOUNTLP.dll,
PCOUNTOP.dll, PCOUNTPA.dll, EQPORTMONITOR.dll,
FXSmon.dll

Explanation
This w ill ignore documents monitored by Adobe,
PCounter, Equitrac, or Microsoft Fax Print Monitor.

This w ill ignore documents led trough these ports:
FILE:, WebEx Document Sharing Port, SHRFAX:, XPSport: Window s file printer, WebEx, Microsoft Shared Fax
Driver or XML Paper Specification Document Writer.
ModiPrint
Specify the Print Processor

Processor
The Print processor is part of the print system of Windows, with the Modiprint option no spool file will be created, the data
will be send to a file, this can not be monitored by DocuPRO. That is why it is in the ignore list by default.

DocuPRO
Allow printing before spooling is finished
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Allow printing before the printer is finished with spooling. This can be done to improve the speed of the system.

Allow release via Inepro Client
Allow the user to release the print job via the Inepro Client.

Ask for Payment confirmation
Should the user be asked to confirm payment?

Auto detect print server gateways
Should the server gateways be detected automatically? This option is used to guide the popup to the right client. In use
with Novell it will send the popup to the client our suite uses in stead of the Novell client. This can also be done for
Macintosh, Linux, etc.
This option is disabled by default.

Auto link cards
When an unknown card is presented by a known user who has entered a job code, if confirmed by the user, the card will be
linked to this user by using the Windows login name under which the job code was generated. Inepro Client must be
installed on the workstation to enable job code generation.
See PayConServer settings for auto-linking account tags.

Daily Purge
If print jobs from yesterday or older in the print queue should be removed, opt for using the 'Daily Purge' option. The 'Daily
Purge' option will delete all the content of all the print queues that are monitored by DocuPRO on a specific time (by default
03:00).

Daily Purge Hour
The specific hour on which the 'Daily purse' option will delete the DocuPRO monitored print queues.

Delete minimum (0) spool files
Delete spool files that have a small size. When the copier has corrupted (these are often very small) spool files.

Print Job Forwarding
Enable Follow-me?

Find Inepro Client By Username
When the Inepro Client cannot be found distinctively by IP-address, it can be found by user name.

Follow-me spool delay in milliseconds
Set follow-me delay in milliseconds. Some copiers need a delay, because they cannot process print jobs send directly
after each other.

Generate popup when just one cost center available
When just one cost centre is available and a cost centre must be entered, it could be done automatically without a pop-up,
if a pop-up is still desired enable this option.

Hide job name in Print queue
Mask all print job names with the name 'DocuPRO document' to prevent content guessing by unauthorised viewers.
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Inepro Client Logo
Show custom logo aside to the Inepro logo in the Inepro Client. This image will not be resized, but shown 1:1 in the Inepro
Client. So if the image is made very large, the Inepro Client window will be bigger then the screen. We recommend a
resolution of approximately 200x200. This will be a link to the image.

JobCode Digits
How many digits should a job code have (we advise a minimum of 3).

Jobscanner Debug level
<Obsolete>

Jobscanner level
Level 2, fall back to level 1

Inepro job scanner, fall back to simple scanner

Level 2 only

Inepro job scanner only, no fall back

Level 1, fall back to level 2

Simple scanner, fall back to Inepro job scanner

Level 2, fall back to level 1 w ith alert Inepro job scanner, fall back to simple + e-mail

When 'Level 2 is selected, fall back to level 1 with alert' the Inepro scanner will fall back to the simple scanner and send an
e-mail to the administrator warning him that the Inepro job scanner is no longer used and the software had to fall back to
the simple scanner. The email address that was filled out at the installation of DocuPRO server is used.

Keep spoolfiles on job complete
For troubleshooting purposes the spoolfiles of the printed jobs can be kept.

Max costcentres count in Inepro Client
Set the limit of the maximum nuber of cost centres that can be displayed in the Inepro Client.

Minimum Spoolfile size in bytes
The size that a spool file should minimally be.

Overwrite login name with client name
The Windows login name is overwritten with the user name in the job file. This is necessary when using Apple MAC's or
allowing users that are not known in the Active Directory to use it.
Only disable this if users with Apple MAC's or users that want to use their laptop in the system (they can then enter
their user name in the Inepro Client, which will overwrite their laptop's Windows name)are not allowed to use the system.

Printjob time to live
How long may a printjob exist in the system? This function can be used separately or in conjunction with th Daily Purge
function.

Run Jobscanner with higher priority
Should the job scanner have higher priority then the other applications on the server?

Use anonymous job codes per job
When using anonymous job codes, should every job have a separate job code or one code for all jobs?

Use Inepro Print Service
<Obsolete>
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PayCon Server
Prerequisites:
§ DocuPRO hardware installed
§ DocuPRO devices connected with IBOS.

Where
§ Main Menu\Tools\System Settings\PayConServer

PayCon Server
PayCon server is the server component that controls and handles all the traffic to and from the Terminals.

Auto Create online Accounts
Whenever an unknown tag is read in our system a new account will be created and the tag will be linked to this account. In
this way someone could use his bank card or any other tag that can be read, to load money and use that money in our
system. Many object that are able to transmit their unique ID can be used as a tag.

Confirm Cost Centre Selection
Confirm the Cost Centre Selection in the PayCon. The Cost Centre is shown confirmation will be asked.

Auto retry failed transactions
The PayCon transmits his transaction log in the XML format. Because of the limited memory available to the PayCon it, all
they fields are numeric values or ID-tags. The PayCon server will then translate those fields into more readable data by
cross referencing with the database. After the XML file is 'translated' it is send to the database and the information is
stored. Only then the XML file will be deleted. If for some reason the data is corrupt, the corrupted XML will be stored as
'Failed transactions' in the 'Failed transactions' directory.
Failed transactions will be retried at the specified time of 'Retry failed transactions at' option.

118

-

IBOS CashPRO

Configure System Settings

Save successful transactions
If this value is set then in stead of only the corrupted 'translated' XML files, all 'translated' XML files will be stored. Only used
for troubleshooting purposes.

Store PayCon 2 transaction XML
The raw PayCon 2 transaction XML files will be saved. Only used for troubleshooting purposes.

Confirm cost center selection
When enabled the Cost Centre selection must be confirmed.

Create new cards
When presenting an Inepro card that is not yet known in the system it's possible to:
1. Create this as a new card without a warning.
2. Create this as a new card and send a warning.
3. Create this as a new card, block it and send a warning. (The card cannot be used in the system until it is unblocked by
the administrator).

Retry failed transactions at
Set a time at which the failed transaction are retried. 'Auto retry failed transactions' must be enabled.

ScanToX server address
The IP address where the ScanToX service is running.

ScanToX service enabled
Will the scanToX service be used?

Subscription Printer
<Obsolete>

Update unassigned PayCon's
Update the price mutations, Red lists, etcetera to all the PayCon's also those unassigned in the terminal menu.
Normally to would needlessly overburden the system, so this setting is disabled by default.
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Inepro Back Office Manager
Prerequisites:
§ None

Where
§ Main Menu\Tools\System Settings\Inepro Back Office Manager

Inepro Back Office Manager
Inepro Back Office Manager is the user interface for the Inepro Back Office Suite.

Customer photo path
The base path of the User image. When importing User data from a *.csv file photo's can also be imported. A photo import
needs the complete name of a file (path + filename). If this path is often the same, it can be set to the path here after which
only the filename in the *.csv file needs to be filled out.

Inepro Licence Server
Prerequisites:
§ None

Where
§ Main Menu\Tools\System Settings\License Server

License Server

License Server Address
The IP-address of the license server. The licence server is a mandatory component that can be installed separately, when
that's done, the database wizard must not be run. Enter the Licence server address as a global value in this field in one of
the managers.
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AccessPRO
Prerequisites:
§ AccessPRO hardware installed
§ AccessPRO devices connected with IBOS.

Where
§ Main Menu\Tools\System Settings\AccessPRO

AccessPRO
PayCon server is the server component that controls and handles all the traffic to and from the Terminals.

Anti-passback enabled
The Anti-passback function will lock out a pass that has just been read for use in that direction trough the gate again, the
pass must first be used in the other direction. This will prevent a user to give his/her pass to a friend without a legal pass on
the other side of the gate for illegal access.

Dashboard enabled
Enable the dashboard function. This means the dashboard utility that shows the user photo (for 4 gates at the same time)
and if access has been granted or not and a workstation.

Dashboard IP address
The IP address of the workstation running the dashboard utility.

Dashboard TCP port
The TCP port of the workstation running the dashboard utility.

Exit always possible
Whatever the rules say, the 'Outside world' zone can always be entered, in other words it's always possible to exit the
building in case of an emergency.
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Create Discounts & Permissions
Prerequisites:
§ None

Where
§ Main Menu\Data\Create Discounts & Permissions

Create Discounts & Permissions
To give discounts to a group can be a complex thing especially when multiple discounts compound each other.
Inepro has a discount system that can handle these advanced discount models.

Terms and concepts
We use a number of terms and concepts in the Discount option that must be known.
Discounts that are 'in effect' or 'effective discounts', are discounts that would (also) effect the group that a discount is
created for. Discounts will only effect each other if they effect at least one of the same (sub)groups (Users, Devices, etc.).
When evaluating Discounts the lowest price is always chosen!
Basic Price

The price that is in the Product or Paper Price table.

Fixed Price

Initially the Basic Price optionally altered by 'Fixed Price' Discounts fields. When no fixed price has been entered, the basic
price w ill be used.

Quantum
Discount

When more than the quantum is bought in one session this discount w ill apply per product.

Session

The time period from the moment a user presents a card to the Terminal until the moment he removes that card.

If there is no 'fixed price' field set in the effective discounts, the Base Price would be used as 'fixed price' value.
Cumulative Discounts and Relative Discounts will be evaluated on the lowest fixed price in effect.
Quantum Discount will differ in 'Single Vend' and 'Multi Vend' mode. If a product is sold and directly charged (Single
Vend), like a copy in a copier, there is no way of knowing if the quantum in that session will be reached. This will mean no
discount will be giving to a product until after the quantum has been reached. If a list of products is created and than
charged (Multi Vend) like in a cash register application, the quantum discount will be given to each product (provided the
quantum is reached by the total amount of products on the list).
For example if the quantity is set to 5 and the Discount to 50%, and I make 20 copies (Single Vend) normally costs 10¢. I
would pay 10 ¢. for copies 1-5 and 5¢. for copies 6-20. I would have to pay €1,25 ((5 x 10¢. = 50¢.) + (15 x 5¢. = 75¢.)) If I
bought 20 pieces of candy (Multi Vend) that each cost 10¢. with the same Discount in effect I would have to pay €1,00 (20
x 5¢. = €1,00) because of the 'Multi Vend' mode.
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Quantum Discount
If multiple Quantum Discounts are in effect they would add up, for example if I have a 10% discount at 5 items and a 20%
discount at 20 items and I would purchase 22 items, I would get a 30% discount (10%+20%) because I purchase 5 or more
items and I would also purchase 20 or more items.
Happy Hour

A specific time a day a discount w ill be given.

Continuous period

A time frame (w hich can span months) in w hich a discount w ill be given.

Fixed Discount

A fixed discount, this is w here the 'fixed price' is set.

Absolute Discount

A percentage of the basic price.

Cum ulative Discount A percentage of the low est fixed price that w ill be added to all other cumulative discounts
Relative Discount

A percentage of the low est fixed price.

Fixed discount
Use this discount to effectively change the price into the price at which the product will be sold. So if the basic product
price is (€)10,00 and the discount is (€)9,00, the product would cost €9,00.
But if another was already set to (€)7,50, the product would cost €7,50. This is because Discounts will always look for the
lowest fixed price.

Absolute discount
Sell this product with a discount of a certain percentage of the basic price. So if the basic price is (€)10,00 and the
discount is 9(%) the product would cost €9,10.
But if another Discount would have already set a Fixed discount price to (€)6,00, the product will be sold for €6,00. This is
because Discounts will always look for the lowest Fixed price.

Cumulative discount
Sell this product at a percentage of the lowest fixed price. This percentage will be added to the other Cumulative Discount
percentages. So if the basic product price is (€)10,00 the discount is 5(%) and there is already a cumulative discount of
8(%), the cumulative discount will be 5% + 8% = 13%. So the product will cost €8,70.
But if another Discount had the fixed price already set to (€)4,50, the product would cost €3,96; (13% of €4,50). This is
because Discounts will always look for the lowest fixed price.
Only Cumulative Discounts are added, the only other influence on discounts that use percentages is the 'fixed price'
field in the current discount and the other Discounts.

Relative discount
Sell this product at a percentage of the lowest fixed price. So if the basic product price is (€)10,00 the discount is 12(%)
the product price will be €8,80. But if a fixed price was also set to (€)7,00, the product price would be €6,16.
The Discount order can be a very complex subject, it's only needed when multiple discounts are in effect and not all
should be in effect in a specific case.

Discount order
If many discounts are in effect it is possible that there are some cases in which it is unwanted for all the discounts that are
in effect to add up. In those cases a stop must be placed in the row of the discounts that are in effect in that specific case.
The order in which the row is ordered is fixed. The row is ordered by adding all the used discount fields for each discount.
Each has a different value as can be seen below:
64

32

16

8

4

2

1
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Happy hours

Continues
period

Quantum
Discount

Card Group Device Group

Product
Group

Product

For example the discounts a user can enjoy are:
Discount 1

Happy hours

Quantum Discount Card Group Device Group

Discount 2

Product Group

Device Group

Card Group

-

Discount 3

Product

Continues period

-

-

The order numbers for the example discounts are:
Happy Continues Quantum Card
hours
period
Discount Group

Device Product
Product
Group Group

Total

64

0

16

8

4

0

0

Discount 1 has order num ber 92
(64+16+8+4)

0

0

0

8

4

2

0

Discount 2 has order num ber 14
(8+4+2)

0

32

0

0

0

0

1

Discount 3 has order num ber 33
(32+1)

The highest number will be applied first. So the order is: Discount 1 (order number 92), Discount 3 (order number 33),
Discount 2 (order number 14).
In this case Discount 1 is processed first, Discount 3 second and Discount 2 is the third Discount being processed.
So if the 'stop looking for further discount entries' box is checked in the Discount which uses 'Product' and 'Continues
Period' (Discount 3), the software will not take Discount 2 into account because it is further down the row then Discount 3
where a stop (the check box 'stop looking for further discount entries') has been placed.
For a complete list of all the available options go to Appendix A:
Discount Order List on page:
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The discount screen
A discount can be created on a Product or
on a Product Group. Discounts can be
applied on even smaller groups by also
selecting a Device Group, a Card Group, a
Purse Type, Department (only for
PosPRO / CashPRO and printer
discounts) and a quantity (only for print
discounts).
With Periodical discount the discount can
be set for a selected period of time.
Furthermore the discount amount and the
way it is applied can be set in the
Discount group box.
Only one kind of Discount may be filled
out in this box.

And finally the 'stop looking for further discount entries' must be ticked to make sure no more discounts are applied.
Permission is used to prevent or enable groups to use this product / product group.

125

Steps

Example A
School A has three card Groups, 'Teachers', 'Students' and Guests.
The teachers at school A do not have to pay 7¢. for a Black and White paper like the students, they can copy and print at
a fix price of 4 cent. on the teacher copiers. If they print they get a 50% discount. Teachers and students can also use the
old printers, if they do they get an additional 10% discount. Everybody who prints 25 pages will get a 'Large User' discount
of 60% but they do not want it to be added to other Discounts. There is a printer rush during lunch time on every day but
Monday, so the school has decided to make printing 9% cheaper outside these hours during daytime. On every evening the
printing is made just a little cheaper (3% discount) because it is also busy time. Guests will pay the normal price at any
time, but can enjoy the 'large user' discount.
How can we make this happen?
We must remember that we can only use one discount type per Discount.
1.
Select the Product Group 'Copy'
2.
Select the Card Group 'Teacher'
3.
Set 'Fixed Price to 4 (4¢.)
4.

Click

to save this discount.

We need to do this for the printers also:
1.
Select the Product Group 'Print'
2.
Select the Card Group 'Teacher'
3.
Set 'Fixed Price to 4 (4¢.)
4.

Click

to save this discount.

Now we will assign the 50% printing discount:
1.
Select the Product Group 'Print'
2.
Select the Card Group 'Teacher'
3.
Set 'Cumulative Discount' to 50 (50%).
4.

Click

to save this discount.

Now we will assign the 10% discount for old printer use for the teachers:
1.
Select the Device Group 'Old Printers'
2.
Select the Card Group 'Teacher'
3.
Set 'Cumulative Discount' to 10 (10%).
4.
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Now we will assign the 10% discount for old printer use for the students:
1.
Select the Device Group 'Old Printers'
2.
Select the Card Group 'Student'
3.
Set 'Cumulative Discount' to 10 (10%).
4.

Click

to save this discount.

Now we will assign the 60% discount for 25 pages:
1.
Select the Product Group 'Print'
2.
Set Quantity to (25) (25 prints)
3.
Set 'Absolute Discount' to 60 (60%).
4.

Click

to save this discount.

Now we will assign the 9% discount for office hours except on Monday. We can not make printing more expensive so we
will have to make the others hours cheaper. We can not select a period that is not effected by the discount so we will have
to make two discounts, one for the mornings from Tuesday till Friday and on for the afternoons.
We will
1.
2.
3.
4.

start with the mornings:
Select the Periodical Discount to 'Happy Hours'
Set Start Time to '08:30' and End Time to '12:00'
Check every day but Monday
Set 'Cumulative Discount' to 9 (9%).

5.

Click

to save this discount.

Now we will set the afternoons:
1.
Select the Periodical Discount to 'Happy Hours'
2.
Set Start Time to '12:30' and End Time to '17:00'
3.
Check every day but Monday
4.
Set 'Cumulative Discount' to 9 (9%).
5.

Click

to save this discount.

Finally we will set the evenings:
1.
Select the Periodical Discount to 'Happy Hours'
2.
Set Start Time to '17:00' and End Time to '22:00'
3. Set 'Cumulative Discount' to 3 (3%).
4.

Click

to save this discount.

127

Steps

The Result
So the at what price will a teacher and a student print during the different parts of the day?
The discount 'Large User 60%' is not linked to the other discounts because it is not cumulative and the calculations for a
teacher copying will not be used in this example but are shown just to provide a complete picture:
The 'Large User 60%' Discount (for printing > 25 pages):
Pages
12
27
50
200

Total Cost
€ 0,8400
€ 1,8060
€ 2,4500
€ 6,6500

Price per Print
€ 0,0700
€ 0,0669
€ 0,0490
€ 0,0333

The 'Teacher Copy' Discount:
Moment
Rush Hour
No Rush Hour, Day Time
Evening

Price per Copy
€ 0,0400
€ 0,0364
€ 0,0388

First we see the discount table for printing or copying more then 25 pages, it will show that copying 200 pages or more is
cheaper for a teacher then copying them separately. However printing 200 pages would make no difference because he
would get the lowest Discount and all the teacher print Discounts are making it so cheap for the teacher to print that even
the 60% rate would not make it interesting for him to print 200 pages.
If the 'Teacher old printing' Discount was the only Discount in effect, printing the pages separately would be more
expensive, but the 'Teacher - Print for 50%' Discount would also be in effect and that those discounts added up will make it
cheaper...
These are the prices for 1 print:
The 'Student' Discount:
Moment
Rush Hour
No Rush Hour, Day Time
Evening

Price per Print
€ 0,0700
€ 0,0637
€ 0,0679

The 'Student - 10% Old Printer' Discount:
Moment
Price per Print
Rush Hour
€ 0,0630
No Rush Hour, Day Time € 0,0573
Evening
€ 0,0611
As has been seen the students can never print cheaper than their teachers. They could however get a better price per page
if they would print more than 25 pages. The more pages (over 25) they print, the cheaper it would get because of the
"Single Vend" mode described above.

128

-

IBOS CashPRO

Create Discounts & Permissions

The 'Teacher' Discount:
Moment
Rush Hour
No Rush Hour, Day Time
Evening

Price per Copy
€ 0,0400
€ 0,0364
€ 0,0388

The 'Teacher - Print for 50%' Discount:
Moment
Price per Print
Rush Hour
€ 0,0200
No Rush Hour, Day Time € 0,0182
Evening
€ 0,0194
Teacher print for 50% of the normal price but it is cumulative, so if there would be another discount they would be added.
The 'Teacher - 10% Old Printer' Discount:
Moment
Price per Print
Rush Hour
€ 0,0360
No Rush Hour, Day Time € 0,0328
Evening
€ 0,0349
This Discount will never be in effect alone, for a teacher, because the software would automatically switch to the cheaper
'Print for 50%' Discount. The two discounts will however be added to each other and their cumulative discount is presented
in the next table.
The 'Teacher - Print for 50% + 10% Old Printer' Discount:
Moment
Price per Print
Rush Hour
€ 0,0160
No Rush Hour, Day Time € 0,0146
Evening
€ 0,0155
If the teachers are printing on an old printer, they would get the most cheapest price per print possible, especially during
daytime outside 'rush hour'..
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Enable Reload Functions
Prerequisites:
§ This function was not enabled before (it will then be invisible in the menu).
§ Reasons defined

Where
§ Main Menu\Tools\Enable reload functions

Enable Reload Functions
To reload the Accounts with money the reload functions must be enabled by choosing the option in the Tools menu. After
that an Account can be reloaded by right-clicking it and choosing 'Reload' and be able to replace card (and let the system
transfer the balance to the new card).
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Fill in the amount and if it was paid in cash or not. Press 'OK' to confirm.
The ability to 'add' money to the system creates a risk. It can attract corruption and can cause unbalance in the
bookkeeping. The Supervisor rights are needed to enable it and at least User management rights to use it. Use this
function with caution!
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Link an Account and a tag to a User
Prerequisites:
§ None

Where
§ Main Menu\Basic\Accounts

Link a Tag to an Account
Users are identified by their card or tags. To links a User to a tag follow these instructions:

1) Create Account + Tag
a) Go to Accounts
b) Click 'Add Account'
c) Change user or user code to the desire user
d) Check and if not correct change the other information press next
e) Check and if not correct change the purses, press next
f) Present a tag to the Administrative Terminal, and it will be linked
g) A message box will pop-up to confirm this.
2) Link to a Tag
a) Go to Accounts
b) Double-click an Account or select it and click 'Edit Account'
c) Press 'Next' twice to get to the Tag screen
d) Present a Tag to the Administrative terminal
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Print and Create Tags
Prerequisites:
§
§
§
§
§

Users defined
Accounts defined
Card Layout
Card Printer
Card Printer License

Where
§ Main Menu\Basic\Accounts

Print and Create Tags
Tags are objects that can present a unique ID to a reader. They don't have the ability to be written, however objects that are
used as a Tag sometimes do, like Mifare cards.
When an object like a Mifare card has on it information from the Inepro system, it will also be a Inepro Card.

To create a tag:
Open the Account window, go to the tag screen and present the tag to the reader, the tag should be added and a dialog
screen appears to confirm this.

To print a new tag:
· Right-click the account that the tag belongs to, and click 'Print tag'.

To print a tag that has already been connected to an account:
· Delete the tag from the account and insert it in the card printer to be the first card fed and then choose 'Print tag'.
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Print Subscriptions
Prerequisites:
§ Subscription Printer
§ Subscription Layout

Where
§ Main Menu\Advanced\Subscriptions

Subscriptions
When a subscription printer is available, it is possible to print out subscription cards in a monochrome color and when the
card is return the subscription printer is able to erase the print on the card again. The card can now be re-used.
These card are used for subscriptions like a season ticket for the bus or train. When it is time to renew the subscription
card, the user will return it, the printer will then erase the old data and write the new data (period and user data) on the
card.
Inepro Back Office Manager supports these subscriptions and provides the user information in our database to be used for
the creation of these subscription cards.
Before a subscription can fully be entered a subscription layout should have been created.

Subscription
The unique name for the
subscription
Description
A description
Subscription Start
The date from w hich the
subscription is valid
Subscription End
The date through w hich the
subscription is valid
Subscription Layout
The layout used for the
subscription
Nam e
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Photo Context Menu
Load logo from file Load a logo image to print on
the subscription
Save logo to file
Save this image back to a file
Delete logo
Delete the logo stored in our
database
Copy to clipboard
Copy the image to the
clipboard
Full size preview
Preview the image full size.

Cards - Acounts - Tags

Replace a Card / Tag
Prerequisites:
§ None

Where
§ Main Menu\Advanced\Site Types

Replace a Card / Tag
When a User has lost his old card or tag, it must be replaced. Follow these instructions to replace a card or tag.

1) Replace Card
a) Make sure the rights to reload credit to a card in IBOS are available and that 'Enable Reload Functions' has been
activated.

b) Go To Cards
c) Double-click a Card or select it and click 'Edit Card'
d) Click 'Move Balance to new card' If the Button is not there, then the reload functions are not enabled.
e) Click 'Yes' if asked if the card must be put on the 'Red List'; this means the card will be blocked.
f) Create the card with printer or Admin Terminal.
2) Replace Tag
a) Go to Accounts
b) Double-click an Account or select it and click 'Edit Account'
c) Press 'Next' twice to get to the Tag screen
d) Delete the lost or stolen tag
e) Present a new Tag to the Administrative terminal
f) Put the Empty card on the PayCon if the card must not be printed, else choose 'Create <Card technology> card
with Card Printer' (Where <Card Technology> is the card technology chip card or Mifare).

g) Change user or user code to the desire user
h) Check and if not correct change the other information press next
i) Check and if not correct change the purses, press next
j) Check and if not correct change the Card Layout
k) Finish (if the card print option was chosen, the card will now be printed)
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Block / Unblock a Card
Prerequisites:
§ User tags or cards

Block / Unblock a Card
In the Inepro Back Office Suite a card or tag can be 'locked' or 'blocked'. A card or tag can be locked when it has been
taken from a terminal too soon, it can be blocked by a system administrator to prevent users to use the card.
A system administrator will can lock a card directly when it is available to him at his desk with the Administrator Terminal.
He can also lock the the card in the system; 'Normal Block Pending' and the card will be send to the lock lists of all the
Terminals and the locked value on the card itself (in a SVC system) will be set to true when this card is presented to a
terminal.
A card will be permanently locked when a card is replaced and the money is written to a new card, these cards can never
be unlocked again.
Cards that are 'normally blocked' or 'normally blocked pending' can be 'unblocked'.
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Locked Cards
Prerequisites:
§ User tags or cards

Where
§

Locked Cards
In the Inepro Back Office Suite a card or tag can be 'locked' or 'blocked'. A card or tag can be locked when it has been
taken from a terminal too soon, it can be blocked by a system administrator to prevent users to use the card.
A terminal will lock a card when it will enter the terminal and will not unlock it until the transactions on that card could be
completed. When a card has been taken out too soon be the user, it will need the card back to complete the transactions
and unlock the card.
The terminal shows that the card has been locked and the user should go back to terminal <long number> (which locked
the user) to unlock the card again.
To look up which terminal belongs to the number, go to the 'Advanced -> Terminals' menu.
The terminal has locked the card because the user has taken it out too soon. Because of this the transactions that were
made with the card could not be completed. To complete the transactions, the user must go back to the terminal and
present the card.
All the other terminals will display the message 'Card Locked By <Current Terminal Serial Number>'.
Should the user be at the correct terminal, and still get the message 'Card Locked By <Current Terminal Serial Number>'
then something has gone wrong and the card was not deleted from the lock list. To remove it from the lock list, go into the
PayCon menu and go to 'Main Menu -> Card / ID -> Edit Card', and present the user card, cycle trough the values and set
the value 'Blocked' to '0'. Test the card again, it should now be working fine again.

137

Steps

Moving Balance from an Account to a Card
Prerequisites:
§ Account
§ Card printer (optional)

Where
§ Main Menu\Advanced\Site Types

Moving Balance from an Account to a Card
When using a combined system (Stored Value Card / Stored Value Server), it's possible to need a balance transfer from an
Account to a card. Follow the instructions below to do this:

1) Moving Balance from an Account to a Card (Only in a combination system: SVC/SVS)
a) Go to Accounts
b) Double-click an Account or select it and click 'Edit Account'
c) Click "Move Balance to New Card"
d) The message 'Default Tender for customer "<User Name>" is blocked. Select a new tender for the customer in the
customer edit screen.'

e) Put the Empty card on the PayCon if the card must not be printed, else choose 'Create <Card technology> card
f)
g)
h)
i)
j)
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with Card Printer' (Where <Card Technology> is the card technology chip card or Mifare).
Change user or user code to the desire user
Check and, if not correct, change the other information press next
Check and, if not correct, change the purses, press next
Check and, if not correct, change the Card Layout
Finish (if the card print option was chosen, the card will now be printed)
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Scheduled Reports
Prerequisites:
§ Alert Email configured and tested (if they should be emailed)
§ Folder with enough space (if they should be stored on disk)

Where
§ Main Menu\Advanced\Site Types

Scheduled Reports
In our software certain tasks like the generation of reports can be scheduled.
This can be done in the scheduled tasks screen or the report tool wizard.

With Task Scheduler
In the scheduled tasks screen an overview of the tasks that are already scheduled is shown and this is also the place to
schedule new tasks.
Importing from LDAP or CSV should be scheduled in the Inepro Data Import Service!
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To schedule a new task press the

button and pick a report to schedule.

When the task is an import, follow the wizard. If the task is a report, the report screen as shown here is presented. The
start period should be filled out, just as the schedule frequency, the device and other details.
When finished assign a file name to this scheduled report and press
.
Every interval (hour, day, week, month or year) the report file that is assigned will be replaced with a report that starts at the
start time and date increased with that interval. So if a report is created with the start date of 07-05-2007 and end date 1005-2007 and the interval (scheduler) set at "month", a report for 07-05 to 10-05, 07-06 to 10-06, 07-07 to 10-07 etcetera,
etcetera will be ceated.
The existing file will be overwritten.
We recommend using the Inepro Balance Scheduler for scheduling budget or other changes in the balance of user
cards or accounts.
We recommend using the Inepro Data Import Service for importing data from *.csv file or Active Directory.
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Part

Advanced Tasks

Replacing a Server
Prerequisites:
§ Existing server

Where
§ Main Menu\Advanced\Site Types

Replacing a Server
Changes in the IT-system might result in the decision to replace the server that runs our services and / or contains the
database server.
In this case follow these instructions:
1)
2)
3)
4)

Write down license box number. Find this number on the license box.
Install the new server.
Move software to the new server.
If the IP-address has changed:
a) Change IP-address in Business Server.
b) Reconnect license box to server with config tool.
5) If the server was also the Database server or the IP-address of the database server was also changed.
a) Change host name / IP-address everywhere in the system to point to new database server.
6) Reload license file.

Where to change the IP-addresses
Business Server
If address of the location of the Inepro Business Server has changed, change the address in the config managers to the
correct address:
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License box
If the license box must be pointed to the address of the license server, so if the IP-address of the license server has
changed, please change it in the license box also.
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Changing the IP-addresses / host name of the Database server
DocuPRO:

IBOS:
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PayCon Server:
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Remove a User (User data) from the System
Prerequisites:
§ Undesired User(s)

Where
§ Main Menu\Basic\Users
§ Main Menu\Tools\Import Users and Related Details via CSV
§ Main Menu\Tools\Clean Database...

Removing User (Data) from the System
Users can not easily be deleted from the Inepro system once they have made a transaction. This is because a User has a
Card and or an Account-Tag with transactions, these transactions cannot be deleted as they would cause a financial
unbalance in the system.

Manual
As Users can be deleted as long they did not made a transaction, if they did, they cannot be deleted manually. The User
can be detached from the card and the card or account can be deleted, but the card or account will not be removed from
the database, only from the view. Furthermore, the aggregated data will still be visible in the reports.

*.csv
Users can be deleted by using a *.csv file, but with the same restrictions as a manual removal.

Clean Database
With the clean database the database can be purged up through a certain date. At that moment all User and transaction
dating from before that date will be eliminated, and cannot be retrieved ever again.
So before using this procedure, make a backup from the database and verify it's a correct functioning backup.

Prerequisites:
Undesired User(s)
A *.bak backup from the IBOS database.

Where
Main Menu\Advanced\Site Types

The user data and their transactions are stored in the database. This will accumulate to a large amount of data over the
years. Sometimes the old data and old user transactions are no longer needed. This data can be purged using the Cleanup
Inepro Back Office Suite database tool.
This can started under Tools => Clean Database.
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Warning: Make sure the data is no longer used and that the financial balance between the data that is about
to be deleted and the remaining data is zero. Otherwise the financial overview will no longer be accurate.
Warning: Always create a database backup before executing a cleanup action.
When the Cleanup Tool is started from the Inepro Back Office Manger this window will be shown:

1. Because the Cleanup Tool w ill access the database, the m anager (that also has access to the database) needs to be closed.
Press OK.

2. Execute one of these actions.
Action
Cleanup all transactions before

Description
Cleanup all the transactions that occurred before the date
entered.

Cleanup all inactive users
Cleanup all users of tendergroup
Clear database
Restore backup database

Cleanup all the users that belong to the specified card /
account group.
Delete the backup database! Make sure a backup is available
on another location, the backup on the server w ill be erased!
Restore the existing backup.
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3. Every actions in the Cleanup Tool w ill have a confirm ation box, m ake sure that the current action is the action that should be
perform ed and that the financial balance betw een the data that should be deleted and the rem aining data is zero.
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VII

Part

Terms & Concepts

Terms & Concepts

Prerequisites:
§ Existing server

Where
§ Main Menu\Advanced\Site Types

150

-

IBOS CashPRO

Configuration

VIII

Part

Configuration

Import Users and Accounts
Prerequisites:
§
§
§
§
§
§
§
§
§
§

Device data (if importing Devices)
VAT (if importing VAT)
Product Groups data (if importing Product Groups)
Product Template data (if importing Product Templates)
Department data (if importing Departments)
Cost Centre data (if importing Cost Centres)
AccessPRO User Groups (If importing Users and using AccessPRO)
Departments (If importing Users or Cost Centres)
Cost Centres (If importing Users or Departments)
User data in Excel sheet, *.csv, LDAP, like User code, name, barcode, photo path, department, etcetera (If importing
Users)

Where
§ Main Menu\Tools\

Import Data
Data can be imported in different ways from different sources, this section will explain how.

Mutate: Insert, edit or delete
The Inepro Back Office Suite will allow to mutate data from different sources. These sources are:
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Manually

Manually enter the data w ith the keyboard in the Inepro Back Office Suite

Im port via *.csv file

Use the 'Tools -> Import Users and related details via CSV...' menu in the Inepro
Back Office Suite.

Im port via LDAP
(Active Directory)

Use the 'Tools -> Import Users from Active Directory...' menu in the Inepro Back
Office Suite.

IBOS CashPRO

Import Data

This table will show which data can be inserted with which method:
Manually

*.CSV file

LDAP

Inepro Data Im port Services

Devices
Product Groups
VAT
Product Tem plates
Departm ents
Cost Centres
Departm ent - Cost
Centre link
Users

User import can be performed by all methods.
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Insert User data manually
Prerequisites:
§ Existing server

Where
§ Main Menu\Basic\Users

User general data
We will create User using some example data, to replicate this three departments (1, 2, 3) and three Cost Centres (A, B,
C) are needed.
1. Go to the

"Users" window.

2. Click the
"Insert User" button.
3. The screen shown below (twice) will open:
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Photo

Photo of the user. This can be a *.jpg, *.jpeg, *.gif, *.bmp, *.w mf, *emf or *.ico file.

User Code

Unique number to identify the user.

Departm ent

Assign the user to this Department

- other fields -

These field are easy to understand

Default Cost Centre

The default Cost Centre is the Cost Centre that the costs w ill be booked to,
chosen if no other choice has been made

Mailing

Does the user w ant to receive marketing information

Bar Code

Barcode is a field that is used to print a bar code on a User card w ith the print
lay-out. Usually this is also the User Code but sometimes bar code specific stop
and start characters like 'A' are necessary for the bar code to w ork.

Valid From

This field can set a date from w hich the user can use the system, set by default
to 1-1-1900.

Valid To

This field can set an end date through the user can use the system, set by default
to 1-1-2100.

Default Tender

This is used w hen the user has more then one card / account. This field w ill
specify w hich 'Tender' (a specific card or specific tag) is primarily used for
payment.

Personal Balance

The current amount of Personal Balance of this User

Printed

When printing user cards it is very useful to see w hich cards have already been
printed. This field w ill be set to 'true' if a card is printed.

4. First we fill in the user code, this should be a unique code. The Inepro Back Office Suite automatically generate the
codes, it will do this by default, or the codes can be overwritten with custom codes. In this case the generated code
was used (20060510153215).
5. Department can be used as a way to group users in the organisation structure. We will set it to the second department.
6. The first name of this user is 'Bobby'.
7. The infix of his name is 'de'.
8. His surname is 'Generic'.
9. Bobby currently lives in the Asylum Office building in New York so the first address line is 'New York Asylum Office'.
10. The second line: 'One Cross Island Plaza, 3d Floor'.
11. The third line: 'Rosedale, NY 11422'. These address fields can also be used (if they are not used to store an address) to
store other data that can not be stored in another field.
12. The city is: 'New York'.
13. His zip code 'NY 11422'
14. The Country :'United States of America'.
15. His home phone :'555-1234567'.
16. The phone at his work place :'555-7654321'.
17. His cell phone :'06-78912345'.
18. The fax :'555-9876543'.
19. His email address: 'b.degeneric@hotmail.com'
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20. He is a 'male'.
21. He wishes to be addressed with 'Mr.'.
22. The birth date is :'9-11-1995'.
23. The default Cost Centre is the Cost Centre that the costs will be booked to, chosen if no other choice has been made. It
will be read-only, and should be set to:'Cost Centre code B' in the Cost Centre menu.
24. He doesn't mind being approached for marketing purposes. (Mailing is checked).
25. His user number is on the card as a barcode.
26. This user is valid from 1-1-1900
27. This user is valid trough 1-1-2100
28. His default tender is his User card, if he had an account with a tag, it could have also been that tag.
29. His Personal balance is '0'.
30. His card has not been printed yet.

Windows Login
When using the 'Secure Release' accounting template in the DocuPRO module, the system will link a print job to a user by
windows login name.
In this field the user's log-in-name must be entered. Go to the 'Windows login' tab and press the Add button
new / insert menu. Enter 'Bob' as Windows login name.

to open the

Cost Centres

A Cost Centre is the location where, in bookkeeping, the costs of a product are being made. Users can book their costs on
this Cost Centre. They can either do this directly or via their department.
Go to the Cost Centres tab .
Press the Add button

to assign a Cost Centre to this user. Enter Cost Centres A and B, make B the default.

Accounts
This will show all the Accounts linked to the User.
Go to the Accounts tab. Press the Add button

to create an Account for this user.

Cards
This will show all the Cards linked to the User.
Go to the Cards tab. Present a card to the PayCon to add a new card.
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Import from CSV
Prerequisites:
§ Existing server

Where
§ Main Menu\Tools\Import Users and related details via CSV...

The screen shots are taken from the 'Easy' version of the wizard.
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When the CSV wizard to import data tables from a Comma Separated Values files is started, the choice between 'Easy'
and 'Enhanced' is shown.
Unless very specific wishes on how the data is stored (kind of type and the format) are required and/or instructions are
given to choose 'enhanced' by our support team, 'Easy' should always be chosen. Click

.

Connect the *.csv files to the tables in the Inepro database by clicking the "File" button next to the table that needs to be
filled and selecting a *.csv file.

This is the Import Settings screen where the properties of the *.csv files will be set.
Check the 'First row column name header' if the first line in the *.csv file hold the field names or headers of the data.
Set the character used as delimiter in the Delimited field. This is the character at the end of a value in the *.csv file. It is
usually a ';' or a ','.
In the 'Import Actions' field the action of the imported information can be chosen, 'Insert', 'Update' or 'Delete'.
Click
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For each table a screen like this will be shown.
It must be defined which field in the file links to which field in the table in the database. Unless column headers are used,
the columns in the file are represented by 'F1, F2, F3, etc.' The fields in the database are listed below on the panel 'User
Fields'. Link all the fields in the file (for example the field 'F1') with all the fields in the database. The table below will explain
the different fields in the database that can be linked to. If the fields are linked up, click
Field

User Code

Type

Text (50)

.

Description
If the 'User Code' field is left blank, no user
data w ill be imported. Leave this field
intentionally blank, if the card or tag data
needs to be impotered, and w ill link the users
later.
It's recommended to link the data w ith the
import right aw ay.

Department Code

Integer

This is linked to the Department Code field
('Advanced -> Department' menu).

Cost Centre Code

Integer

This is linked to the Cost Centre Code field
('Advanced -> Cost Centre' menu).

First Name

Text (50)

Self Explanatory

Infix

Text (10)

Self Explanatory

Last Name

Text (50)

Self Explanatory

Address 1

Text (80)

Address 2

Text (80)

Address 3

Text (80)

The address fields, aside from the users
address, they can be, and are often, used
for other data that has no appropriate field.

City

Text (30)

Self Explanatory

Zip

Text (10)

Self Explanatory

Country

Text (30)

Self Explanatory
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This window will link even more data about the user. If the fields are linked up, click
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Field

Type

Description

Phone Home

Text (25)

Self Explanatory

Phone Work

Text (25)

Self Explanatory

Phone Mobile

Text (25)

Self Explanatory

Fax

Text (25)

Self Explanatory

Email

Text (100)

Self Explanatory

Gender

Text (1)

'M', 'm' or '1' for male
'F', 'f' or '2' for female
'0' or empty for unknow n

Title

Text (15)

A Users title (like 'Mister', 'Ms.', 'Sir')

Birth Date

Text (50)

Self Explanatory

Mailing

Boolean

Does this user w ould like to be emailed? Set to 'Yes' if he or she does, to 'No'
if he or she doesn't. Usually used by companies in combination w ith our
Marketing module.

Bar Code

Text (200)

The bar code, an alphanumeric code that can be printed as a bar code on a
card, using the Card Layout.

Photo

Text (50)

The path + filename of a photo. This parameter can also be set in the 'Tools ->
System Settings -> Back Office Manager -> Customer photo base path'.

Valid From

Date / Time

From w hich date can this user use the system.

Valid To

Date / Time

Until w hich date can this user use the system.

IBOS CashPRO
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In this window a card can be linked to the user, per *.csv file import one or mor cards or tags can be linked to a user. Link a
card code to the card, this code is a unique code, used to identify the card. If using tags (in a SVC environment) the ID
code of the tag must be known. (A tag can be a chip card, or Mifare card created as tag, but also a electronic key chain or
other electronic identifier with a unique code). A balance can be put on the Card or on the Account. Finally link the user to
it's Windows login name, so the user is able to use the 'Secure Release' Accounting Template in the DocuPRO module.

If Cards / Accounts are not linked to the Windows login name (and also if the User Code field is left empty, therefore not
importing Users), this warning is shown. Confirm this with 'Yes' and continue to import. When finished linking the fields,
click

.
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The import preparation has now finished.
To exit the wizard and start the import, click

.

After the import a report is generated, this will show if there where errors, if the import has succeeded and how many
records where imported, when it is done and the report is reviewed, click
Check if the files are correctly imported!
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Extrude required data for import from CSV from data available in an Excel file
These formulas might be specific for a certain version of MS Excel and might not give the required result in everyone of
the versions. They are provided as-is and are not supported or accepted as subject by our support department.

Extruding customized gender type
This Excel statement will convert textual gender data like 'M' and 'F' into the numeric data used in our database:
=IF(<TextualGenderData>="";0;IF(<TextualGenderData>="<TextualFemaleGender>";2;IF(<TextualGenderData>="<Textual
MaleGender>";1;0)))
For example:=IF(A1="";0;IF(A1="F";2;IF(A1="M";1;0))) A1 is the field with the gender code. The formula will
convert an empty field to '0', an 'F' field to '2', a 'M' field to '1' and all other values to '0'.
The English 'F' and 'M' can already be used as aliases for 2 and 1, but in other languages use this formula.
A1

Extruded Value

F

2

M

1

X

0

b

0

w fg

0

unknow n

0

Extruding customized (bar) code
Some bar codes, like 'CodaBar' need a letter start- and end character. If a fixed length is also necessary and the unique
numbers differ in length then it is hard to generate these kind of bar codes. A field with the fixed length of the bar code is
needed, and with this Excel formule a valid codabar bar code can be generated:
="<StartChar>"&REPEAT(TEXT("0";"0");<FixedLength>-(LENGTH(<UniqueID>)+LENGTH("<CompulsaryCode>")))
&"<CompulsaryCode>"&TEXT(<UniqueID>;"0")&"<EndChar>"

="A"&REPEAT(TEXT("0";"0");$C$1-(LENGTH(B1)+LENGTH("3000")))
&"3000"&TEXT(B1;"0")&"A". Where 'A' is a CodaBar required start/end character, C1 is the field with the required
For example:

fixed length of the code, '3000' a specific number / text the school wanted in their bar code and B1 is the student's ID field.
B1

C1

Extruded Value

123

12

A000003000123A

56789

12

A000300056789A

56789

9

A300056789A

56789

18

A000000000300056789A

2356

18

A000000000030002356A

Student1

18

A0000003000Student1A
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Searching values in Excel
Use when fields from columns are needed to create a new field with the gathered data. In this case make an export from
Users from the Inepro Back Office Manager and compare those records with the table that has the User code and some
other extra field of data and give the matching extra data for that user code.
Use this formula:
=INDIRECT(ADDRESS(MATCH(<SeachValue>;<SearchRange>;<MatchCode - Important, must be 0!>)
+<Increment>;<ColumnNumberResultValue>))
This formula will find and use only the first result, so make sure the search value is unique.
For example: = INDIRECT(ADDRESS(MATCH(D1;$B$1:$B$100;0)+1;3))
Where D1 is de value searched (ie. the User Code), $B$1:$B$100 is the location to search (ie. the column with User
Codes in the search range, where $ is used to ensure that the search range remains fixed), 0 is the match code, this
should always be 0 when comparing text fields like this, the increment value is to compensate for an included header row in
the search range that will make the row index too low by one. 3 is the column number A=1, B=2, C=3 etcetera. So we
search column B (numbered from 1-100), but we want the result to be, what is in column C in that same row. (in this
example C is the value of in words).
B

C

D1

Extruded Value

124

One Hundred Tw enty Four

124

One Hundred Tw enty Four

141

One Hundred Forty One

141

One Hundred Forty One

192

One Hundred Ninety Tw o

192

One Hundred Ninety Tw o

In some versions of Excel local keywords are used and statements like 'IF' and 'TEXT' might be different, it can also be
that instead of a " a ' must be used and then the ';' must be replaced with a ','.
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Introduction
In these release notes all relevant information regarding this release can be found. Please read these release notes
carefully and make sure they are understood. We strongly recommend not to roll out this release of software directly on the
working system but to test it first before going life. If there are questions, remarks or a problem should be reported please
send an email to support@inepro.com.

Disclaimer of warranty
Inepro BV makes no representations or warranties, either express or implied, by or with respect to anything in this
document, and shall not be liable for any implied warranties of merchantability or fitness for a particular purpose or for any
indirect, special or consequential damages.
Copyright © 2010, Inepro BV.
All rights reserved.
"Inepro BV" and Inepro BV’s products are trademarks of Inepro BV. References to other companies and their products use
trademarks owned by the respective companies and are for reference purpose only.

Purpose
The purpose of this document is to help install and configure Inepro Data Import service. This document will not cover the
installation of IBOS, the Active directory or the creation of CSV files. This document is intended for users that want to
import user data into their existing and running IBOS installation.
Definitions, Acronyms and Abbreviations
IBOS
= Inepro Back office suite
IDIS
= Inepro Data Import Service
SVS
= Stored Value Server, using central account with tags
SVC
= Stored Value Card, using cards
CSV
= Comma Separated Values
LDAP
= Lightweight directory Access Protocol
AD
= Microsoft Active Directory

Minimum Requirements
·
·
·
·
·
·
·
·
·

IBM Compatible PC, Intel Pentium, 1GHz (or higher)
Windows Server 2003 or 2008 (32 or 64 bit)
1 GB RAM
20 GB HDD free disk space
NTFS file system
Display resolution 1024 X 768 or higher
Working SQL server with IBOS database
A backup of this working database
Administrator rights
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Installation
Installation
IDIS can be installed by executing the setup file. The following welcome screen will be displayed.

Click next to continue.
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Please read the License agreement carefully and accept it, if there are no objections.

Please select a destination folder for the installation of IDIS and press next to continue.
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The following screen will ask where the programs shortcuts in the start menu should be placed, leave or edit this and press
next to continue.

The installation of IDIS is now completely configured, this screen will sum up all the settings that where made during the
setup, click install to start the actual installation of IDIS.
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If the installation was successful, the final screen of the installer is shown.
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Configuration
After IDIS is installed we can start configuring the service. IDIS can be configured by using the “Inepro Data Import Settings”
program for which a shortcut has been created in the start menu.

Make sure a recent backup of the IBOS database has been made before using IDIS!
When IDIS is configured incorrectly or wrong data is imported, there is now way to revert any changes made to the
database.

The Inepro Data Import Service must be started with Administrator rights!
When the application is started, the main screen will appear, on the right there are several buttons to create, copy, delete
and edit templates. The properties button leads to a menu where changes can be made to the name and description of a
template and set a template active or inactive.

To create a template, use the buttons on the right or right click anywhere in the white area to get the same options.

170

-

IBOS CashPRO

Import Data

The following screen will appear
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Fill in a name and an optional description for the template, set the template as active if it should be used straight away. The
actual import of data will start when the application closed. When the OK button is clicked, the template will be shown in
the details panel.

Select the created template and use the “Edit template” button or right-click on the template and select “Edit template”
from the menu.
We can now start editing the selected template.
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If a template description is entered during the creation of the template, it should show up in this screen as well, it can be
modified.
The next step is to make a choice for the import source, this can either be an LDAP server or a CSV file. The choices will
affect the configuration options that must be entered later.
Finally, enter the IBOS database settings. Make sure the connection settings are filled in correctly, since IDIS will try to
extract data from the database during the configuration process.
When all settings are configured correctly, press next to continue. If CSV is selected as a data source, please continue
with following chapter “Configuring CSV templates”. If LDAP is selected, please continue with the chapter “Configuring
LDAP templates”.
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Configuring CSV templates
With CSV as the import source selected, the following screen will be shown.

Browse to the CSV file. If the file can be opened correctly, a preview of 25 lines is shown to check whether the correct file
is selected.
Below the preview, a few options can be set for the CSV file, please set these appropriately to prevent wrong data from
being imported.
Click next to continue to the following screen.

As a final check, the CSV data can be seen as it will be imported. Please check if all the columns are interpreted correctly.
The configuration has now been completed for the CSV portion of the template, click next to continue setting up the final
settings for the import.
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Configuring LDAP templates
After LDAP has been chosen as the data source in the previous screen, the following screen will appear.

To setup the LDAP data source, enter the address of the LDAP server, this can be a DNS name, IP address or domain
name. The correct LDAP version and port number should be modified, if they are not set to standard values.
When the Server address is entered, click on “Fetch DNs” to get available base paths from the LDAP server. Make sure
this base path is configured correctly to ensure proper data import.
Enter the correct credentials connecting with the LDAP server and set SSL if needed. Extract all attributes or just the ones
that are actually used in the LDAP server. When ready, click on “preview data” to check whether the correct settings have
been entered.
Click next to continue setting up the final settings for the import.
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Final configuration
After the data source has been configured completely, select the fields to import. Simply click on the ones to use, a
summary of the selected fields will appear in the right column.

After selecting the desired fields, click next to continue.
After selecting the desired fields, connect these fields to the desired IBOS data fields.
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To connect a data field to an IBOS field, simply click on the arrow next to the field to display a drop-down-list of the fields
earlier selected and select one.
All the fields displayed in red are mandatory. Furthermore, User code, Windows Login, Account Code and Tag ID Code
MUST be unique.
When importing fixed data into the IBOS database, simply check the “fixed value” box next to the field and enter the value
to import for all users.
If importing Gender values, use the following:
Male = M,m
Female = F, f, V, v, H, h, W, w, K, k
Not specified = Any other character.
When importing dates, please make sure 4 digits are used for the years, since all 2-digit years will be interpreted as 20nn.
The exact date format can be configured in the next screen.
If satisfied with all the settings, click next to continue to the next screen.
This is the final template configuration screen.
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Set the template active, if the template is not set active, it will not be used to import data.
If desired, select from which date, data should be imported. It's recommended that the date is set to “All” when running the
template for the first time.
When importing Departments, Card / Account Groups or Cost Centers configure IDIS to create these automatically when
non-existent.
Finally set the desired Date-format for the import. As noted before, always use 4-digit years.
Configuration of this template is now complete, click Finish to save this template. The main screen will return
automatically.
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Starting the service
After all the desired templates are completely configured, close the application.

When prompted to start the import service. When choosing not to restart the service, this can be done manually via
Windows Services Control or by restarting the server where IDIS is installed.
If the rights to remotely restart the service, are not available to the current user, an error dialog will appear.
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Import from LDAP (like MS Active Directory)
Prerequisites:
§ Existing server

Where
§ Main Menu\Tools\Import Users from LDAP...

Import User data from Active Directory or rather LDAP by using 'Active Directory import', we will go by the different settings
below:

Host
Base
Port
Protocol Version
Fetch DN's (only for LDAP v. 3)
Use SSL secured connection
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IP address or DNS name of the destination LDAP server.
The root to link to the server. In case of using LDAP v3 servers, leave this field empty to connect w ith the
root DSE.
A TCP/IP port used to connect to the destination LDAP server
Which protocol is used voor all the communication w ith the server. Can be set to version 2 or 3.
Normally LDAP v3 servers publish their lists w ith top level contexts. To receive this list, press this button.
Note: if setting up a connection to a LDAP v2 server, know the naming context to w hich a connection is
made.
Use a Secure Sockets Layer connection.

Import from LDAP

Rem em ber connection
settings
Usernam e
(usernam e@dom ain)
Passw ord
Anonym ous connection
Filter: Users only

Test Connection

All the connection setting including the log in settings w ill be kept.
A legitimate username on the domain w ith the necessary authentication.
The passw ord of this username.
Please check this option to make an anonymous connection w ith the server and skip the username and
passw ord.
By default w e filter during the connection on 'Users only'. But there are LDAP servers that do not support
this, in this case this option needs to be deselected, otherw ise no data w ill be show n.
The 'Test Connection' button can be used in tw o different w ays, firstly w hen the connection settings have
been entered the button can be pressed to check if a valid LDAP server is present at the inserted address.
When the account field are also set (username and passw ord) then the user is also authenticated.

LDAP Protocols
We support LDAP protocol version 2 and version 3.

Version 2
·
·
·
·

Windows 2000 compatible
Linux LDAP server compatible
UMICH compatible
OpenLDAP 1.X. compatible

Version 3
· Retrieve Base

Base DN is the root in the directory structure that points to the location that has the wanted user data. Base DN’s are
appointed by the server, most of the time 4 or 5 suggestions will be made. A local administrator should know which of
these is the correct one. With version 2 that will have to be set manually.
To request DN's on a Windows 2000 server despite using LDAP protocol version 2, if version 3 is used, then request
the DN settings and then switch back to version 2 (the connection would not work for Windows 2000 Server if it is not using
protocol version 2).

Secure Internet connection with SSL
A connection can be made by using the SSL (Secure Sockets Layer) protocol, the default port that is used for this
connection is 639 (when in doubt consult the system administrator).
If no secure connection is used, the default port will be 389.

Log in to LDAP with user name
In some cases it is necessary to fill in the domain after the user name, it's usually not necessary, it depend on the local
settings of the LDAP server.
In some cases an anonymous connection is also supported, but this is often a 'read-only' connection which will only show
some fields, so this is not usable in most cases. This also depends on the local security settings.
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Select columns
Active Directory (and LDAP in general) have many columns that can be specified, to avoid the clutter and keep the import
window simple, select which columns should be shown. Check the boxes in front of the necessary columns.
Note: Some of the columns will be needed in the table no matter what, a warning that this column is needed will be
given, if it is inadvertently deselected.
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Link User fields

On top of the screen the Inepro Back Office toolbar to sort and filter is available.
Adding the correct Card Group enables the tool to create purses for the accounts. Connect multiple purses to a card group,
like personal credit, unlimited budget.
The card group can be linked in 2 different ways:
1. By a pre-defined column in Active Directory in which data that has the Card Group that is known in the Inepro Back
Office database. This column needs to be created in Active directory and should have the correct Card Group linked to
each User. Using this way, a user can each have a different card group while being imported together with user that
have a different Card Group.
2. By selecting the Card Group from the list of available Card Groups in the Active Directory import window. This will give
every user that is imported the same Card Group.
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Create / Edit / Lookup Windows login
Prerequisites:
§ None

Where
§ Main Menu\Basic\Users

Create / Edit / lookup a Windows login name in Inepro Back Office Manager
When using the DocuPRO module to let User pay for printing, the user that is printing a job must be linked to the user in
the Inepro Back Office Suite database. This is done by the Windows login name under which the user is printing. So the
Windows login name of the user must be known in the Inepro Back Office Suite database.
In the User screen four pages are shown at the bottom of the User Detail screen, the last page is labeled 'Windows Login
Name'. Add the login name of the user there (use the
Add Button). When at the main user screen access the context
menu (by right-clicking) and search which user is linked to a given Windows login.
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Configure Terminals
Prerequisites:
§ Terminals

Where
§ Main Menu\Advanced\Terminals

Configure Terminals
For a User to interact with the Inepro system they need a terminal. These terminals can be anything; PayCon's, IP-readers,
Payon Touche's, etcetera.
They must be connected to the server to enable their use in the system. How each of these type should be connected is
explained in this section.

Configure PayCons
Prerequisites:
§ Existing server
§ Linked PayCon(s)

Where
§ Terminal Settings --> Network (in PayCon)

The following steps need to be executed in order to successfully connect a PayCon with the Inepro Back Office server:

Set PayCon network configuration (DHCP/fixed IP)
The PayCon network configuration can be set in the 'Terminal Settings' --> 'Network' menu.
A DHCP can automatically provide a IP-Address for each computer (or other network device) that needs one. Set it to either
Dynamic Host Configuration Protocol (DHCP) if the PayCon should try to automatically retrieve an IP-address from the
DHCP-server or to 'fixed' for a pre-set fixed IP-address.
For DHCP a DHCP-server is needed in the network.
If set to 'fixed' the IP-address must be set and optionally the subnet and gateway settings according to the network
requirements.
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IP-address
The IP-address needs to be in the IP-range for example if the server address is 192.168.0.1 the Terminals IP-address
should start be 192.168.0.x where 'x' is a number between 1 and 254 (or rather between 10 and 255 because the first 9
numbers (1-10) often are often dedicated to other important network devices). Although each part of the IP-address has a
range of 0-255, the numbers 0 and 255 have a special meaning and can never be used.
The subnet address is used for sub-netting (a way to divide the network into smaller networks), but in most cases sub
netting isn't used and the value can be left to the default value '255.255.255.255'.
A gateway is a network point that acts as an entrance to another network and is often also the proxy-server and router for
the network, usually it's the first IP-address in the range. So if for example the range is 192.168.0.x then the gateway's IPaddress would be 192.168.0.1 or if the range is 10.0.0.x the gateway's IP-address would be 10.0.0.1.
The easiest way to make sure the IP-address is pointing to the correct server: go to the Start menu on the server running
the PayCon Server service and choose 'Run' then type 'cmd' to go to the command prompt and type 'ipconfig' and press
enter.

The IP-addresses of the default gateway and the subnet are shown in console screen.
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Set Server-IP in PayCon
In the network menu of the PayCon ('Terminal Settings' --> 'Network'), the IP address of the server on which the PayCon
Service service is installed must be manually set. The easiest way to check the IP-address of the server is go to the Start
menu of the server on which the PayCon Service service is installed and choose 'Run' then type 'cmd' to go to the
command prompt and type 'ipconfig' and press enter. The address at the line 'IP-address' is the servers IP-address.

Reboot PayCon
After making the network settings the fastest way to have the PayCon appear in the back office manager software is to
reboot the PayCon (disconnect the power chord for a few seconds then reconnect and wait until the PayCon has
completely rebooted).

Back Office Manager
Now start the Back Office Manager and go to the menu item Maintenance – Terminals… Here the PayCon should be
seen.
When this screen was already opened the refresh button

must be clicked to refresh the data in the view.

When successful the PayCon should appear in the above view with his serial number, the server to which he is connected
and its IP address.

Configure DocuPRO Devices
Prerequisites:
§ Existing server

Where
§ Main Menu\Advanced\Site Types

DocuPRO Devices
DocuPRO devices are copiers, multi-functional's and printers.
Printers are automatically imported. When the printer is installed in Windows it will be imported as DocuPRO device.
Copier need to be added manually. Multi-functional's are created by adding the device as a Windows printer (letting the
device be imported as DocuPRO device), then adding a copier and merging them into one device.
How these devices can be configured will explained below.
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Configure Printer(s)
Prerequisites:
§ DocuPRO

Where
§ Main Menu\Basic\DocuPRO

Configure Printer(s)
Printers must be configured in DocuPRO to determine what DocuPRO will do when prints are send to this queue.
In order to add a printer to the DocuPRO Software first add the printer in Windows.
When the printer(s) has been added, start the Back Office Manager software. Now restart the services Tools -->
Restart Services. In the manager now go to the

Devices view and the newly added printers should be seen.

Shouldn't the printers appear in the view, press the refresh button
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Configure DocuPRO Devices

Configure Accounting Template
Prerequisites:
§ DocuPRO
§ Windows printer queues
§ DocuPRO has been restarted after printer installation

Where
§ Main Menu\Basic\DocuPRO

Configure Accounting Template
Configuring the DocuPRO accounting template, will set the DocuPRO behaviour. Printer pools and the interaction between
the user and DocuPRO is set here.

The Accounting template
A group of settings that determine how the printer and printer jobs will react on the commands of the server.
The DocuPRO software offers some different modes of functionality. The most important modes are shown in this chapter.
Monitor Active

Monitor printer activities

Printer Queue

The printer's queue

Printer Pool

The pool the printer belongs to

Server

To w hat server is the printer connected

Accounting Tem plate What template does the printer use
Paid Printing

Does the user have to pay?

Secure Release

Use Secure Release?

Cost Centres

Use Cost Centres?

Paper Size Fall back

Can the printer fall back to a smaller paper size?

Accounting

Accounting mode

Job Codes

Job Code Mode

Account

Silently / Chip card emulation / Client side conformation

The Paper Size Fall back setting
When the printer can not print on the specified paper it will fall back to a smaller size. For example if it is set to true and A3
is printed while there is no A3 paper left, then the print job would be printed on A4 paper. Also if a Paper Type is used that
is not recognised the width and height of the paper will be calculated and the price of the paper type that is the most like
the paper used will be charged.
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The Accounting setting
Disabled

None of the transactions are registered

Accounting

The transactions of registered users are registered

Accounting Anonym ous Allow ed

The transactions of all users are registered

The Job Code setting
Disabled

Don't use Job Codes

User Job Codes

Unique Job Code per user until the job Code list is empty

Session Job Codes

Unique Job Code per session until the job Code list is empty

Anonym ous Job Cobs

Unique Job Code per print job until the job Code list is empty

The Account setting
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Monitor Active

The print is using the online account, w ithout any conformation

Chip Card em ulation

The user must identify him / herself at the PayCon and activate the print job

Client side conform ation

The user must confirm the print job on the computer he or she is at in a pop-up screen

IBOS CashPRO
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The next table provides an overview of the different templates and their specific needs:
Requirem ent

Client Softw are

User Im port

Accounting only Optional

Netw ork term inals

No

Optional

Job Codes

Yes

Yes

No

Secure Release

Yes

Optional

Yes

Cost Centres

Optional

Optional

Yes

The following print configurations are available:
1.

Accounting only

Page

2.

Job codes

Page

3.

Secure release

Page

4.

Cost Centres

Page

Accounting only
'Accounting Only' mode will register all printed jobs in the database. This is commonly used when the print-outs do not
need to be paid immediately. This mode does not require any hardware.
Network scheme:
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Job codes
When using Job Codes a pop up screen with a random number is displayed each time a print job is launched. This number
is then used to select and pay for the job at the printer. This is the ideal solution for schools, libraries … The Job Code
mode enables the user to send a number of print-jobs to the server and print only a selection of these jobs.
Network scheme:
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Secure release
The Secure Release feature connects a login name to a specified id. Typically this id is the unique number of a the user's
card connected with the Windows login name. Therefore all printed jobs can only be printed out using this particular id.
This safe mode of printing can also be combined with the above modes of operations.
Network scheme:
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Cost Centres
With the Cost Centre Feature specific users can book their print costs on the Cost Centre.
A Cost Centre is the location where, in bookkeeping, the costs of a product are being made. Users can book their costs on
this Cost Centre. They can either do this directly or via their department.

Network scheme:
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Configure Copier(s)
Prerequisites:
§ None

Where
§ Main Menu\Basic\DocuPRO

Configure Copier(s)
A copier under DocuPRO is a machine that is used in DocuPRO only to copy (and/or scan & fax) but not print! A device
that can also print under DocuPRO is called a multi functional.
To add a photocopier to the database start the Back Office Manager, and go to the
In the data view, right-click and select 'Insert…' or click the Add button

Devices view.

.

Now fill in a short and long name for the copier, and select
a Product Templates which applies best. Do not forget to
enter the correct site information.
For adding a terminal to the copier go to the Terminals tab
and select the Add button

.

Now select a terminal for this copier.
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Configure Multifunctional(s)
Prerequisites:
§ None

Where
§ Main Menu\Basic\DocuPRO

Configure Multifunctional(s)
A copier under DocuPRO is a machine that can only copy (and/or scan & fax) but not print! A device that can also print
under DocuPRO is called a multi functional.
To add a Multi functional device (MFD) to the database first install the printer driver and add the printer in Windows.
When the printer(s) has been added, start the Back Office Manager software. Now restart the services Tools -->
Restart Services. In the manager now go to the

Devices view and the newly added printers should be shown.

Shouldn't the printers appear in the view, press the refresh button

on the toolbar.

Then proceed to the Product Templates and change the template to a Multi functional device to also add the copier
products for this multifunctional.
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Configure Vending Machines
Prerequisites:
§ CashPRO
§ A PayCon Vending installed in a running vending machine and connected to the network

Where
§ Main Menu\Basic\CashPRO

Configure Vending Machines
Go to 'CashPRO Devices' and click the
'Add' button.
Fill in the long and the short name.
Set the 'Device Type' to 'Vending Machine'.
Set 'Product Template' to 'Cash Register / Vending Machine'
The site should be set to the location of the vending machine.
The description and address fields can be left open or set to the precise location in the address field.
The extended description of the device can be given in the description field.
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Interface Settings
Prerequisites:
§ Existing server

Where
§ Main Menu\Tools\Interface Settings

Change the main and the small headers
To change the font press this button.
To change the text colour press this button.
To confirm the changes press 'OK', to discard press 'Cancel'.
To go back to the original or default setting press 'Restore default Settings'.
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USB Sticks Procedure
Prerequisites:
§ Existing server

Where
§ Main Menu\Tools\Read out USB Sticks

When terminals are used in the system, that use an USB stick in stead of a network solution to transfer the transactions,
those transactions need to be copied to the database by USB stick. This can be done in both the PayCon server service,
as in the Inepro Back Office Manager.

Receive data from the terminal
1. Plug in the USB stick that has been prepared for use in a Terminal.
2. Wait until the data has been copied.
3. Remove the USB Stick.

Load data onto the server
4.
5.
6.
7.
8.

Go to the Inepro Back Office Suite system.
Click the option 'Read USB Stick' in the Tool menu.
Wait until the data has been copied.
Use the 'Safely remove the USB stick' option in Windows.
Unplug the USB stick.

Load confirmation on the terminal
9. Go Back to the terminal.
10. Plug in the USB stick that has been prepared for use in a Terminal.
11. Wait until the data has been copied.
12. Remove the USB Stick.
It is important to follow this complete routine, so start with the Terminal and end with the terminal. In this way both the
server and the terminal will be updated to the latest status.
It also important to use one USB stick per Terminal.
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Balance Scheduler
Prerequisites:
§ Existing server

Where
§ Main Menu\Advanced\Site Types

Please create the reasons that shall be used in this session with the Balance Scheduler beforehand.
The Balance Scheduler is used to adapt the balances of one or groups of users at a pre-defined date and time interval
limited to a date.
Adapt the balance of a user, Card / Account or department.

Balance scheduler - User properties:
Nam e
Usercode
Username
Destination Purse
Task
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Description
The unique code to ID the user
The username
The purse to change the balance of
The task description

Balance scheduler - Task properties:
Nam e
Task description
Task Active

Description
A descriptive name of the task
Is the task active or inactive
What is the amount this task w ill w ork
Amount
w ith?
Action
Deduct, revalue or fillup to the amount?
Reason
Why is this task executed?
With w hich purse w ill this task
Source Purse
exchange money?
Email notification
The email subject.
Email User
CC the effected user(s)
Start Date
Self explanatory
End Date
Self explanatory
Execution Time
Self explanatory
For example '2' 'Moths' means 'tw ice
Frequency; every
every month'.
A limit on the number of transactions.
So if the task is executed tw ice every
month over the period of one year, 24
executions of the task w ould fire. If
Number of transaction (0=unlimited)
just 15 executions of the task must fire
limit set this field to 15.
'0' means it is limited to the period
betw een the start and end date.

Search User

When the exact username or user code is unknown the 'Search User' function can be used to search for a user by
username, user code or purse.

Creating a task
When a new task is created, it will directly be picked up by the Balance Scheduler service running in the background, and
the task will be executed, when the current time is equal to the execution time.
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Scheduled Tasks
Prerequisites:
§ Existing server

Where
§ Main Menu\Tools\Scheduled Tasks

In our software schedule certain tasks like the generation of reports can be scheduled.
This can be done in the scheduled tasks screen. In this screen an overview of the tasks is shown. Those task are already
scheduled. It is also the place to schedule new tasks.
Importing from LDAP or CSV can be scheduled in the Inepro Data Import Service.
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To schedule a new task press the

button and pick a task to schedule.

When the task is an import follow the wizard like in the unscheduled version. If the task is a report, the report screen will be
seen as shown here. The start period must be set, just as the schedule frequency and the device and other details.
When finished assign a file name to this scheduled report and press

.

Every interval (hour, day, week, month or year) the report file will be replaced with a report that starts at the start time and
date increased with that interval. So if a report has been created with the start date of 07-05-2007 and end date 10-05-2007
and the interval (scheduler) is set at "month", a report will be generated for 07-05 to 10-05, 07-06 to 10-06, 07-07 to 10-07
etcetera, etcetera.
The existing file will be overwritten.
We recommend using the Inepro Balance Scheduler for scheduling budget or other changes in the balance of user
cards or accounts.
We recommend using the Inepro Data Import Service for importing data from *.csv file or Active Directory.
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Troubleshooting
There are many variables that can impact the experience with a software suite as extensive as the Inepro Back Office
Suite. In this area, solutions can be found for any technical issues encountered while using our solution.
If trouble is encountered that's not addressed here? Contact our Inepro Support Desk.
Inepro Support Desk
Support@inepro.com
+31 (0) 252744040

When contacting our Support Desk make sure the following information is available:
· The version number of the relevant software (suite)
· The firmware version number of the relevant Terminal
· The version of the manual(s) used. The version number of this manual is 4.28.9.
· The answers to these questions:
- What is the system expected to do?
- What happend instead?
· The exact steps that where taken to tackle the problem?
· Which error messages where received?
· The system logs
· The relevant *.ini files
· The values of the Inepro Registry settings
· Preparation for a remote connection to the server and optionally the system that has the issue.
We will need:
Logs
*.ini files
Registry
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Tracking User Issues
Prerequisites:
§ None

Where
§ Main Menu\Basic\User Log

Tracking User Issues
A user might have concerns about their credits or have the idea that they should have more credits to their name than they
actually have. They will go to the system administrator to resolve their concerns.

A Help out a student searching for money that he 'lost' in the system
1. Find out between which transactions (time, date, device and product) he/she lost the money.
2. Put the card (or tag) on the Administrator PayCon and note the current balance.
3. Go to User and check the current balance.
4. Click the 'Posponed changes' page and note any messages there.
4.1 If there are messages follow 'Update all Terminals' procedure.
4.2 If the 'Posponed changes' remain contact Inepro Support.
5. Right-click the User and choose 'User log'.
6. Look at the User log to find what has been done with his card or tag and if this is concurrent with the other information
found.

6.1 If not, go to the 'Failed transaction' folder to see if there are failed transactions.
a) If so follow 'Retry failed transactions' procedure.
b) If the problem remains, contact Inepro Support.
7. It should now be clear what happened to the User's money, if not, contact Inepro Support for help.
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Logs
Prerequisites:
§ Existing server

Where
§ %SystemDrive%\ProgramData\Inepro\log
§ %ProgramData%\Inepro\log

(Windows Vista / 7)
(Windows XP)

Logs
Inepro's Back Office Suite stores it's process information, transactions and unexpected issues in log files.
A log file is text file that has a date-time stamp and a description of the executed action or issue.
Our support department will need the log files to analyze reported issues.
The log files can be found here:
%SystemDrive%\ProgramData\Inepro\log
%ProgramData%\Inepro\log

(Windows Vista / 7)
(Windows XP)

*.ini files
Prerequisites:
§ Existing server

Where
§ %SystemDrive%\ProgramData\Inepro\ini
§ %ProgramData%\Inepro\ini

(Windows Vista / 7)
(Windows XP)

*.ini files
Inepro Back Office 's configuration is partly stored in the *.ini files.
An *.ini file is a text file that has per line a keyword, a separator ('=') and value.
Our support department needs these *.ini files to analyze reported issues.
The *.ini files can be found here:
%SystemDrive%\ProgramData\Inepro\ini (Windows Vista / 7)
%ProgramData%\Inepro\ini
(Windows XP)
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Registry
Prerequisites:
§ Existing server

Where
§ HKEY_CURRENT_USER\Software\Inepro
§ HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Inepro

Registry
Inepro Back Office 's configuration is partly stored in the Windows registry. The Inepro support department might need the
an export of the registry to analyze reported issues.
The Windows registry is a hierarchical database that stores configuration settings and options on Microsoft Windows
operating systems.
Use the regedit.exe command to edit or export the registry values.

The key's used by Inepro can be found here:
HKEY_CURRENT_USER\Software\Inepro
HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Inepro

Error Messages
Prerequisites:
§ Existing server

Error Messages
When the software detects an error an error message dialog might pop-up showing you an error message.
The Inepro Support department will need to see the error message, so please either leave the message on the screen, do
not click it away or make a screenshot an save it as an image.
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Card can not be reloaded
Q
The card can not be reloaded at the Inepro Back Office Manager
A
1) Button is not visible
a) Perhaps the reload functions in the local manager are not enabled? (They should be.)
b) Go to 'Tools -> Enable Reload Functions'. See page:
2) The right to reload a card is not granted.
a) Let authorised staff change the authentication level of the staff account used. See page:
3) There is an error message or other reason that the card cannot be reloaded.
a) Contact the Inepro Support Desk.

Move credit to new card
Q
I can't move credit from one card to another?
A
1) Button is not visible.
a) Reload functions are not enabled in the current local manager?
i) Go to 'Tools -> Enable Reload Functions'. See page:
b) Current Employee does not have the rights to reload credit to a card?
i) Let authorised staff change the employee's authentication level. See page:
2) New card is not printed/created correctly.
a) The old card is now permanently blocked and the credit can not be moved anymore.
i) Try the 'Replace a card / tag' section on page:
b) The solutions did not solve my problem.
i) Call Inepro Support.
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Prices are not transferred to the terminal
Q
When new prices are set in the manager for my device (printer, copier, vending machine, cash register etcetera) , they are
not updated in the terminal linked to the device
A
1) The prices might not had enough time to update yet
a) Wait for at least 5 min. before checking if the prices are updated, PayCon Service is checking periodically if prices
(and other information)need to be updated, and will then update them.
2) The value of the prices where not changed in the Inepro Back Office Manager
a) Check if the values of the prices are correct in the Inepro Back Office Manager
b) If they are not, change them and try again.
c) If they are Contact the Inepro Support Desk
3) The device is a vending machine, and has the prices stored in the machine itself, not in the Inepro terminal attached to
it
a) The prices stored in the vending machine can not be changed from the Inepro Back Office Manager
i) Contact de vendor of the vending machine to change the prices
ii) If the prices have been changed, change them in the Inepro Back Office Manager also to let our system charge
and register the correct prices.
4) The problem can't be solved with these solutions
a) Call Inepro Support.
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Terminal is not sending the transactions
Q
The transaction from the terminal (product sales, entering a card) are not send to the database.
A
The terminals will periodically send their transactions to the database, if this is impossible they will be stored on the
terminal.
If they are send but have the wrong format, or data that can't be matched in the database the transaction will be moved to
the 'Failed transactions' folder on the database server.
1) The transactions can't be send, because there is no network connection between the terminal and the server
a) Check if the netwerk connection is ok by pinging the terminal from the server
b) If the connection is not there, the message 'Trx. log full' is shown. The internal transaction storage is full and the
PayCon will not function until the connection to the server is restored. Restore the connection to the server. See
page:
2) The wrong PayConService Server is set in the PayCon
a) Check if the server address in the PayCon is set to the correct PayConService server address
3) There are no transactions to be send
a) No transactions have been made with the terminal, so none can be send to the database.
i) Check if there are any transactions in the PayCon in de 'DB settings -> Transaction Log -> Size' menu, if it's
zero, there are no transactions to be send.
4) The transactions have been send to the server but they contain values that cannot be inserted into the database
a) Go to the server
b) Open PayConServer from the System tray
c) Select 'File -> Retry Failed transactions' from the menu.
d) Note the errors from the transactions that are not processed.
i) A transaction with 'No item found for product x' (where 'x' is the Product ID) needs a product with that number
in the database before it can be processed.
ii) A transaction with 'Transaction from unassigned Terminals are not allowed' needs the terminal to be attached
to a device.
iii) A transaction with 'Violation of UNIQUE KEY constraint 'UK_TenderPurse'. Cannot insert duplicate key in
object 'tblTenderPurse'' is caused during an database update and can only occur with software older than
4.10. This will need a 4.10 update (or higher) to resolve, contact the Inepro Helpdesk.
5) The problem is not solved by these solutions
i) Call Inepro Support.
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Error 9 'Unknown Card'
Q
The terminal shows me 'Unknown Card (9)'
A
This means the scan for all the supported card technologies has produced no results, and no suitable card with a proper
format has been found.
This can be caused by:
1) The card has not been created (correctly)
i) Lay the card on the Administrative terminal (of a Stored Value Card system) and check if the card window has
the title 'New Card' or 'Edit Card'.
(1) If it says 'Edit Card', it has been correctly created but somehow was not detected correctly by the PayCon.
(2) If it says 'New Card', it has not been created correctly and link it to the correct user now.
2) The PayCon says 'Unknown Card (9)' at the Administrative PayCon too, then the card (antenne or chip) is broken.
i) Proximity cards (like Mifare and LEGIC) have an internal antenne, these are thin copper wires that are lined on
the outer rim of the card, when the card is bend these wires are stressed. If they are stressed too much they will
break, and the card will be broken. Card can be bend by keeping them in a wallet, sitting on them, using them as
tools, out of boredom. Chips can be damaged by applying extreme pressure to the card. Chip cards (with
contacts visible on the outside of the card like a bank card) will be less susceptible to damage because they do
not have an antenne but the chip can be damaged just as easily as that of the proximity cards.
ii) A new card will have to be created for this user, check the credit of the old card and move the credit to a new
card, and a new card with the users credit will be created. Remember the 'Enabled Reload options' have to be on
before the 'Move credits to new card' button will be visible.
3) The card reader is defect or something else is causing the problem
i) Contact the Inepro Support Desk
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Nine Digit Number
Q
I go to a terminal and it shows me 'Card locked, <long number>'? What should I do?
A
The terminal shows the message that the card has been locked and the user should go back to terminal <long number>
(who locked the user) to unlock his card again.
1) Look up which terminal belongs to the number in the 'Advanced -> Terminals' menu. See page:
a) The terminal has locked the user's card because he has taken it out/off too soon. Because of this the transactions
that were made with the card could not be completed.
b) To complete the transactions, the user must go back to the terminal and present the card.
2) The user has been to the correct terminal, and still gets the message 'Card Locked By <Current Terminal Serial
Number>'
a) Something has gone wrong and the card was not deleted from the lock list.
i) To remove it from the lock list, go into the PayCon menu and go to 'Main Menu -> Card / ID -> Edit Card'
ii) Present the user card, cycle trough the values and set the value 'Blocked' to '0'.
iii) Test the card again, it should now be working fine again.
b) In all other cases
i) Contact the Inepro Support Desk.
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Connection Failed
Q
The PayCon displays the message:'Connection failed', what could be the problem?
A
1) The PayCon service could have been stopped
a) Is the PayCon service running?
b) If it isn't, (re)start it.
2) The network cables could be broken or disconnected.
a) Check the physical connection between the service and the PayCon.
3) DocuPRO service isn't running (properly).
a) Check if it is running.
b) If it isn't, (re)start it.
4) The 'server' IP-address in the PayCon doesn't point to the machine the services (DocuPRO and PayCon service) are
running on.
a) Set the server IP-address in the PayCon to the server the services are running on.
5) The ports needed to connect with the PayConServer are closed, check if all the ports needed for the Inepro System are
opened.
Toepassing
PayCon Tools
PayCon Tools
PayCon / PayCon Tools
SSH
Internet - HTTP
Tijdsynchronisatie
PayCon <-> Back Office
IneproClient <-> Back Office

Type
UDP
UDP
UDP
TCP
TCP
TCP
TCP
TCP

Num m er
1643
1645
10000-10050
22
80
37
10000-10050
1640
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'...Not allowed'
Q
The terminal shows me '... Not Allowed'
A
1) The terminal has no products
a) Check the terminal with the configuration tool or directly with the Administrator card if it has products in the product
list.
b) If it does not have products, add them in the Inepro Back Office Suite.
2) There is no valid budget on the card with enough credit
a) Check in the Back Office Manager with the Administrative PayCon which purses are available on the card and how
much credit each purse has.
b) Check which purses are allowed on the PayCon.
3) There is a conflict with the deduct / permission rules
a) Check which deduct / permission rules apply to this situation and if buying the product is allowed.

Terminal is not sending the transactions to the database
Q
The PayCons shows 'Trx. Log Full' in the display. What does it mean?
A
1) The PayCon stored each transaction internally until it can send it to the server and gets the confirmation that it has
been written to the server OK.
a) The message 'Trx. log full', means that the internal transaction storage is full because it can't write the transactions
to the server, the PayCon will not function until the connection to the server is restored. Restore the connection to
the server. For more information look at Terminal is not sending the transactions to the database on page: .
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Question Mark returns error message
Q
When I press the question mark, I would normally get the serial number of the PayCon and the time in milliseconds the
signal takes to travel to the server. Now I get 'Ch.Resp.Error' in the line that would normal have the response time.

Example:
123456789
Ch.Resp.Error
A
1) The message 'Ch.Resp.Error' is short for Challenged Response Error, the challenged response is the process that
returns the signal within the response time. So there is an error in the challenged response, that can be caused by:
a) A version conflict; In this case the PayCon (or loader) firmware is incompatible with the (Inepro Gateway or PayCon
Service) server software.
i) Update PayCon firmware.
b) Routing over NAT; Routing over NAT is not supported by Inepro software versions older then 4.10.
i) Update PayCon firmware.
c) Instructions above do not solve the problem
i) Contact the Inepro Support Desk.

The user name in Inepro Client doesn't match
Q
When I am printing a job, the User Name on top of the Inepro Client doesn't match my Account name or login name.
A
1) The login name in the Inepro Back Office Suite is probably linked to a different User. The Inepro Back Office Suite will
first look for a link in the User table and display the name of the user it is corresponds to. If it can not find a link to a
User in the database it will display the login name.
a) Check if the User field in the Account, is it set to the correct User?
i) If it is not, change it to the correct user. This should solve the problem.
ii) If it does not, contact the Inepro Support.

223

Troubleshooting

PayCon can not find print jobs
Q
While using Secure Release, I created a print job and presented my card at the PayCon. After pressing '#' the PayCon
display shows me :'No print jobs available'. But the print job is in the queue with my user name.
A
1) The card number is wrong or not linked to the User in the database.
a) For example the card number is 4567 but the User name is linked to card number 7654. Send a print job, the name
is sent to the Inepro Back Office Suite and the job is linked to card number 7654. When the request to show which
jobs are pending for the card is made, the card number 4567 is checked. That card number has got no jobs pending,
so that is the message the PayCon will show.
i) Check whether the card is linked to the correct user. Enter the User screen, present the card to the
administrative PayCon. The User details of the linked User will be opened. Check if these details are valid, and if
necessary correct them.
2) The job is deleted on the printer or multifunctional.
a) The job may be deleted or blocked on the machine itself due to incorrect settings
b) Call Inepro Support.
3) Other causes
a) Call Inepro Support.

'Credit too low'
Q
The terminal shows me 'Credit too low'
A
1) The terminal has no products
a) Check the terminal with the configuration tool or directly with the Administrator card if it has products in the product
list.
b) If it does not have products, add them in the Inepro Back Office Suite.
2) The credit is lower then the minimum allowed credit that is set in the PayCon, this is normally '0' but can also have a
lower or even higher value.
a) The credit on the purse is too low.
i) Reload this purse at the nearest reloader.
b) The minimum value is set too low (lower than the value default to the project).
i) Raise the minimum allowed credit that is set in the PayCon.
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DocuPRO

Error "Spool file not found"
Q
The error logs show the message "spool file not found" as a cause why my print jobs are not printed. I don't understand
why because the spool file directory has spool files in them.
A
1) Windows File Pooling might be on, DocuPRO requires Windows File Pooling to be off.
a) Check if Windows File Pooling is on.
i) Find the spool folder, Open Printers folder, Server Properties, Advanced Tab.
ii) Look at the *.SPL files in the spool directory. If they are called FPxxxx.SPL then file pooling is on. If they are
called xxxxx.SPL then file pooling is off.
iii) Disable Windows File Pooling. See Microsoft Knowledge base.
2) All other cases
a) Contact Inepro Support

User can not get in / out
Q
A User can not get access to a room or building he/she should get access to, why?
A
1) The Access Rules that apply to you are set incorrectly.
a) Go to the 'Advanced -> Effective Rules' menu.
b) Select the User name, It should show you which rules apply to him / her.
c) Check if these rules do prevent the user to get in.
i) If so change the rules accordingly.
2) The Access Rules do not provide a valid reason why the user is not able to get in.
a) The card or tag can not be read correctly.
i) Check if the card can be read in other Terminals.
(1) If not the card might be broken.
(2) Call Inepro Support.
ii) Check if other card can be read in this Access Terminal.
(1) If not something might be wrong with the card reader.
(2) Call Inepro Support.
b) Other reasons.
i) Call Inepro Support.
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Field Names
Short Name
A name, less then 15 characters long. This field is stored and optionally displayed on the PayCon.

DateTime
This is a timestamp (notation of date and time) that is created at the time this event is logged.

Device Type
The Device Type is a type of device like a 'printer' or 'cash register'.

Product Template
Product Template is a pre-set list of Products or Paper Prices with certain settings already configured. Use it to configure
large groups of products at once.

Site
The site the user, device, product or PayCon is located.

Description
A free field to enter extra information such as a description of the object or it's location.

DocuPRO Product Type
The type of the product, for example a 'print', 'copy'. This is used in combination with Device Type and Product Template to
make sure Document products like 'print' or 'copy' cannot be used on CashPRO devices like a 'vending machine' and vice
versa.

CashPRO Product Type
The type of the product, for example a 'cash register' or 'vending'. This is used in combination with Device Type and Product
Template to make sure Document products like 'print' or 'copy' cannot be used on CashPRO devices like a 'vending
machine' and vice versa.

Paper Type
The job scanner will use this paper type to tell DocuPRO manager what paper type the job is using, DocuPRO will then
inquire which printer is sending the job, if it has a product with such a paper type and then charge the price of that product.
Never assign the same paper type twice to the same printer!
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Field Names

Code
A unique code to identify this object.

Changed
This is a timestamp (notation of date and time) that is created when this record is altered.

Card Type
Defines the type of chip card, like SLE4442, Mifare.

Long Name
A long name (40 characters) is the name used in Windows and the receipt in the PayCon, every other time short name is
used.

User
The user attached to this object.
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Appendix A
Discount Order List
This table is only needed if you want to want to exclude one object (a user, device, group, etc.) from the discounts
that effect them! This is done by placing a stop in the Discount row. But the way in which, the discounts that are in effect
for that group, are ordered must be known.
This is the order in which the Discount row is ordered. For each Discount a number of fields in the Discount dialog is used.
Each combination of fields has a different order number. Product Group and Product cannot be combined. Also Continuous
Period and Happy Hour cannot be combined. Those combination are listed as 'Not Possible' in the last column.
1.
2.
3.
4.
5.
6.
7.

Look for the combination that is used and note the order number.
Do this for each Discount that effects the group.
Order the found Discount by order number.
Determine the Discount to place the stop.
Open Discount screen in the manager and place the stop.
All Discounts with a lower order number will not have an effect.
Save the Discount.

Read more about Discounts in the chapter:
Discounts on page
Discount
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-
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-

-

-

-
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-
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-

-

-

-
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-

-

-

-
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-

-

-
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-
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-

-

-

Card Grp

-

-
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-

-
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-
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-
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-

-

-

Card Grp

Device Grp

-
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-
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Card Grp

Device Grp

Product Grp

-

14

-

-

-

Card Grp

Device Grp

Product Grp

Product

15

-

-

Quantum

-
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-
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-
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Not possible

Not possible
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Not possible

Not possible
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Appendix B
Output Manager Flowchart
The output manager flowchart shows how the settings will effect the print job and the way it is handled.
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Appendix D
Release Notes IBOS 4.26
Revision history
Version Description Date Author
4.26.0 New release 01-03-2013 M. Linting
4.24.0 New release 01-04-2012 R. de Koker
4.22.0 New release 19-07-2011 R. de Koker
4.20.0 New release 15-12-2010 R. de Koker
4.19.6 In between release 17-09-2010 R. de Koker
4.19.3 In between release 29-07-2010 R. de Koker
4.19.0 In between release 16-06-2010 R. de Koker
4.18.1 Minor update 02-06-2010 R. de Koker
4.18.0 New release 01-06-2010 R. de Koker
4.17.0 In between release 19-02-2010 R. de Koker
4.16.1 Update release 25-01-2010 R. de Koker
4.14.2 Update release 09-11-2009 M. Linting
4.14.0 New release 31-07-2009 M. Linting
4.12.0 New release 31-03-2009 M. Linting
4.10.0 New release 28-11-2008 M. Grobbe
4.8.2 Update release 30-06-2008 M. Grobbe
4.8.0 New release 01-04-2008 M. Linting

Introduction
In these release notes you will find all relevant information regarding this software release. The document describes the
changes in all Inepro products i.e. Back Office, Front Office and hardware.
Please read these release notes carefully and make sure you understand them. We strongly recommend not to roll out this
release of software directly on your working system but to test it first before going live. If you have questions, remarks or if
you want to report a problem please send an E-mail to support@inepro.com.

Disclaimer of warranty
Inepro BV makes no representations or warranties, either express or implied, by or with respect to anything in this
document, and shall not be liable for any implied warranties of merchantability or fitness for a particular purpose or for any
indirect, special or consequential damages.

Copyright © 2013, Inepro BV. All rights reserved.
"Inepro B.V." and Inepro B.V.’s products are trademarks of Inepro B.V. References to other companies and their products
use trademarks owned by the respective companies and are for reference purpose only.

Purpose
The purpose of the Release Notes is to communicate the major new features and changes in this release of the Inepro
Software . It also documents known problems and work-arounds.

Scope
This document describes the software release of version 4.26.0

Definitions, Acronyms and Abbreviations
iBos = Inepro Back office suite;
iBom = Inepro Back office manager;
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SVS = Stored Value Server, using central account with tags;
SVC = Stored Value Card, using cards with an E-purse;
ICP = Inepro Cloud Printing;
IBS = Inepro Business Server;
IDIS = Inepro Data Import Service ;

About This Release
This release of the back office software is a major update of the previous version 4.24.0 and also the temporary versions
released in between. It contains changes of the database structure, services and tools, It also includes several new
features and bug fixes for the reported issues from the previous release. This Release also needs an Inepro License Box as
introduced with release 4.20.0, this release will not work without a valid License Box. Please follow the update procedure
as described.

Supported operating systems
• Microsoft Server 2012
•
•
•
•
•
•
•

Microsoft
Microsoft
Microsoft
Microsoft
Microsoft
Microsoft
Microsoft

Server 2008 R2
Server 2008
Server 2003 R2
Server 2003
Windows 7 (client OS)
Windows Vista (client OS)
Windows XP (client OS)

Supported database systems
• Microsoft SQL Server 2012 Enterprise
•
•
•
•
•
•
•
•
•
•

Microsoft
Microsoft
Microsoft
Microsoft
Microsoft
Microsoft
Microsoft
Microsoft
Microsoft
Microsoft

SQL Server 2012 Business Intelligence
SQL Server 2012 Standard
SQL Server 2008 R2 Enterprise
SQL Server 2008 R2 Standard
SQL Server 2008 R2 Express
SQL Server 2008 Enterprise
SQL Server 2008 Standard
SQL Server 2008 Express
SQL Server 2005 Enterprise
SQL Server 2005 Express

Minimum requirements for an Inepro printserver
(Database running on different server)
• Intel Core 2 Duo processor (Intel XEON recommended).
•
•
•
•
•
•
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Windows Server OS (see above operating systems)
1 GB RAM (2 GB or more recommended)
80 GB free NTFS HDD disk space
Print Queues defined as local queues on the server
Supported 100 Mbit Ethernet adapter.
Display setting 1024 X 768
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Updating
All previous versions can be updated with this version 4.26.0 Be aware a database update is needed. The database update
will be done automatically when you start updating the software. Otherwise run the database wizard. After a database
update it is not possible to go back to an older version!

New installations
Requirements:
PayCon firmware 4.26.0 or above

Upgrading an existing installation version 4.22 or earlier
The 4.26 release of iBos is a major software update which requires a good plan to proceed.
1. Make sure you have a working Inepro License Box with a valid license connected in your network.
2. Check the known issues list for blocking issues. Should there be any doubt concerning specific functionality contact
your dealer or Inepro before proceeding to the next steps.
3. Make a full backup of your complete environment.
4. Software update is required on a test-system before upgrading your live environment
5. When there are 3rd party solutions which interact directly with the database all functionalities need to be checked
because of major changes that have taken place in the database structure / usage.
6. The firmware of the hardware terminals needs to be updated to the at least version (4.26.0).
7. All terminals need to be updated from the Manager (tools -> update terminals).
8. Now verification of the functionality of the complete environment needs to be checked, when there are no blocking
issues proceed to the next step.
9. Now your live environment can be updated.

Updating an Offline system.
Since the release has got a major transaction log update (since 4.10) it is important to follow the next steps when updating
a system which works with offline terminals (USB download). This is important since the offline terminals already contains
transactions with the old type of transaction log.

Updating
Upload the transactions from the terminal to the USB stick.
Directly after the uploading of the transactions, the terminal must be updated to the latest software version (4.26.0).
Do the above steps for al terminals which are used in the system.
Now go to the server and download all transactions from the USB stick.
After following the above steps, the update on the server can be performed.
When the above steps are not correctly followed, transactions can be lost!!!

Systems Overview
Database and server/ services are
Back Office applications
MFP and client pc software are front
office applications
Hardware related software is
hardware applications
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Back Office Application
Legend
(
(
(

) Added feature
) Improved/ changed feature
) Bug fix

DocuPRO4
Added setting: “use anonymouse jobcodes per job”. When set to true, the client will show a jobcode once and will not
keep jobhistory.
Costcenters invalid on current date will not be visible anymore in customer and department details selection.
Fixed bug in Job rename for LPD jobs, fixed pointer issue’s in jobnames
Added JobPropertyMapper LPD_DomainName. This Jobpropertymapper adds the domain name to the username so that
users with the same username but belonging to different domains van collect their own job using secure release.
Added setting “hide jobname in follow me queue”. Jobs can be renamed to “DocuPRO Document” when job is forwarded
based on printer rules.
Optimized job renaming in DocuPRO4 for better results and performance.
Fixed bug in restoring outputmanager-state. It could happen that when DocuPRO crashed the outputmanager state file
was incomplete, this caused that not all printers where monitored after restart of DocuPRO, this cannot happen again.
Fixed IneproServiceManager watchdog acting to aggressive. DocuPRO was already restarted bu the
IneproServiceManager when it was still active but responding a little late.
Fixed PayConServer and DocuPRO server stopping if in-between license check fails.
Fixed bug in DocuPRO4 where jobpropertymapper was invoked too early.
Fixed DocuPRO4 freezing when IneproClient used.
Fixed data size bug in JobPropertyMappers.

Inepro Client Popup
Added IneproClient notification which is shown when corrupted printjobs are detected.

Inepro Scan Engine
Added an XPS jobscanner.

Inepro Printerdriver
Added PrinterPools, JobTimeToLive and Daily purge features Inepro Printerdriver.
Added Inepro Cloud Printing support to Inepro Printerdriver.
Restructured printjob logging in Inepro Printerdriver.
Jobcode printjobs with customercodes are now linked to customers in Inepro Printerdriver.
Implemented job change options in Inepro Printerdriver and BusinessServer.
Added Dutch translations for Inepro Printerdriver.
Added JobPropertyMapper LPD_DomainName.
Fixed printrelease with PayCon and Inepro Printerdriver not working without costcenters.
Fixed printerpool detection of input-queues in Inepro Printerdriver.
Fixed several job product and pricing issues in Inepro Printerdriver and BusinessServer.
Fixed problem with daily purge in Inepro Printerdriver.
Fixed Inepro Printerdriver service not stopping.
Fixed Inepro Printerdriver issues with DailyPurge and TimeToLive checks.
Fixed “out of bounds” error in Inepro Printerdriver.
Fixed incorrect pricing for raw print jobs in Inepro Printerdriver.
Fixed Print spooler connection issues in Inepro Printerdriver.
Fixed Cross-Server-follow-me issues with printer pools in Inepro Printerdriver.
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Inepro Cloud Printing
ICP terminals now get print jobs for all follow-me pools.

Inepro Business Server (IBS)
Added PCTimerPRO support to BusinessServer.
BusinessServer now also shows unreleasable printjobs on terminals.
Added BusinessServer setting “AllowJobPropertyModification”.
Added “Reload settings” button to BusinessServer config tool. This button makes it possible to load new settings to the
terminal, without a restart of the service.
Added reliability check of MIB Data to BusinessServer.
Added several MIB Settings to BusinessServer.
Added application types “Copy” and “Print_Copy” to BusinessServer.
Added setting to BusinessServer to disallow fuzzy tag reads.
Added “defaultApplication” setting to BusinessServer for openAPI devices.
Added support for ScanToX in BusinessServer.
Added support for JobCodes in BusinessServer.
Added SessionTimeout setting to ignore accountlocks in BusinessServer.
Implemented job change options in Inepro Printerdriver and BusinessServer.
Added German translations to BusinessServer config tool
Added setting in businessServer for release and display order of printjobs.
Added jobcode support for DocuPRO4 in BusinessServer.
Number of jobcode digits are automatically increased or decreased in BusinessServer.
Added jobcode-time-to-live setting to BusinessServer.
Introduced new LDAP authentication plugin for BusinessServer.
BusinessServer now writes terminal versions and addresses in database.
System defaults cannot be edited anymore in BusinessServer Config Tool.
Implemented Template fallback options for MIB counters nonexistent in template. When transaction is corrected by the
MIB server and the product is unknown in the product template a price fallback will be adjusted so that the transaction can
be stored in the database.
Fixed bug in BusinessServer where products were free if not in a template.
Fixed BusinessServer auto-reconnect for database connection.
Fixed Printjob properties being overwritten by BusinessServer when jobinfo requested.
Fixed bug in BusinessServer where balance could get negative.
Disallow tag-assignment for fuzzy tag reads in BusinessServer.
Fixed BusinessServer service not stopping.
Fixed IPReader reconnect bug in BusinessServer.
Fixed BusinessServer could loop session close events on database exceptions.
Fixed issues with jobcache in BusinessServer.
Fixed BusinessServer stability issues when database connection lost during a transaction.
Fixed small memory leak in BusinessServer
Fixed multithreading issue in BusinessServer.
Fixed several job products and pricing issues in Inepro Printerdriver and BusinessServer.
Fixed bug were printjobs viewed on certain terminals could not be viewed on others.
Fixed jobcode-printjobs with unkown cards being proccessed incorrectly.
Fixed bug in purse assignment during multiple remote tender updates.
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Inepro Data Import Service (IDIS)
Added Languagecode and PhotoPathTemplate to IDIS.
IDIS GUI is now translatable.
Added LastUpdate offset setting to IDIS.
Added option to prefix customercode with same prefix as Windows username in IDIS.
Added Dutch and German translations to IDIS interface.
LDAP authentication now supports Microsoft LDAP server signing protocol
Improved photo-import performance in IDIS.
IDIS templates are now stored in Windows ProgramData folder.
Fixed bug in IDIS where CSV files without columnheaders were not correctly parsed.
Fixed bug in IDIS trying to import empty tag fields.
Fixed “Always import all data” option not working in IDIS.
Fixed bug in auto column name generation in IDIS.

Inepro Database
Added stationtypes for ICP and PCTimerPRO
Added ValidTo and ValidFrom fields to items.

Inepro Database Synch.
DBSync now cleans up tblTerminalUpdate for all mutations older than 1 hour.

Inepro License Server
Added new licensetypes for Inepro Cloud Printing.
LicenseServer now respects IneproDataPath setting.
Fixed LicenseServer being started during setup when database installation selected.
The license server was installed automatically on the database server, now not anymore.

Inepro Reporting
Added report tool shortcut to Windows Start menu during setup.

Inepro Application Service Manager
Added support for IneproBiometricService and ICP in ServiceManager.
IneproServiceManager now ignores stop commands while in restore mode.

Inepro UIS/ API
Added DELETETAG and DELETEPURSE functions to UIS.
Fixed UIS Terminal ID’s not being created unique.

Inepro Scheduler
Fixed issue in BalanceScheduler where jobs were processed infinitely.
Fixed issue where tenderID could be changed by BalanceScheduler.

Inepro PayCon Server
Fixed issue with auto-reload transactions in PayConServer.
Functionality to disable (PayCon II) terminals remotely for maintenance.
Fixed issue StoreID was not assigned in sessiom correction transactions (rounding)
Fixed PayConServer and DocuPRO4 stopping if in-between license check fails.
Fixed bug in auto-retry failed transactions in PayConServer.
Fixed sorting issue with tenderupdates in PayConService.
Fixed problem where PayCon update protocol was stopped in PayConServer.
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Extented costcenter protocol to use default costcenter when no user-interface available.

Inepro MIB Server
Added several optimizations to Konica Minolta MIBPlugin.
Solved memoryleak in Konica Minolta MIB plugin.

Inepro Biometrics Service
Inepro Tagconvertor
Fixed bug in Desfire XOR tagconverter.

Inepro Scan2X Service
Fixed WebDAV SSL issues in ScanToX service.
Added several optimizations to ScanToX service.

Inepro First Time Login
Added Multilanguage version of “First Time Logon”

Front Office Application
Legend;
( ) Added feature
( ) Improved/ changed feature
( ) Bug fix

DocuPRO Embedded for Ricoh
Support for SDK/J 4.xx MFPs
Support for SDK/J 7.xx MFPs

DocuPRO Embedded for Konica Minolta
Support for A4 Konica Minolta devices i.e Bizhub C35 42 and 36

PCTimerPRO
1st release of PC logging and payment application

Hardware Application
Legend;
( ) Added feature
( ) Improved/ changed feature
( ) Bug fix

PayCon Terminal
Expanded PayCon red list from 1000 to 10000 cards.
Fixed print release with PayCon and Inepro Printer driver not working without cost centers.

PayCon Touch
PayConTouch terminals should now connect even without correct registry-settings.
Added reload-settings-notification to PayCon Touch terminals.
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END-USER LICENSE AGREEMENT
INEPRO BACK OFFICE SUITE BY INEPRO BV
THE PROGRAM IS COPYRIGHTED AND LICENSED (NOT SOLD). BY PURCHASING THE PROGRAM, YOU ARE ACCEPTING AND AGREEING
TO THE TERMS OF THIS LICENSE AGREEMENT. THIS LICENSE AGREEMENT REPRESENTS THE ENTIRE AGREEMENT CONCERNING THE
PROGRAM, BETWEEN YOU AND INEPRO BV, (REFERRED TO AS "LICENSOR"), AND IT SUPERSEDES ANY PRIOR PROPOSAL,
REPRESENTATION, OR UNDERSTANDING BETWEEN THE PARTIES.
1. License Grant. Licensor hereby grants to you, and you accept, a nonexclusive license to use the program in machine-readable, object
code form only, for use only as authorized in this License Agreement. The Programs may be used only on computers owned, leased or
otherwise controlled by you. The program shall only manage the number of devices specified in the purchase agreement. You agree
that you may not reverse assemble, reverse compile, or otherwise translate the Program.
2. Term (Demo Version Only). This License commences upon the installation of the software and is effective for 90 days following the
date you install the software. This License terminates automatically without notice from Inepro BV upon the expiration of the evaluation
term or if you fail to comply with any provision of this License. Upon termination you shall remove the SOFTWARE from your
computer(s).
3. Licensor's Rights. You acknowledge and agree that the Program is proprietary to Licensor and protected under copyright law. You
further acknowledge and agree the all right, title, and interest in and to the Program, including associated intellectual property rights,
are and shall remain with Licensor. The License Agreement does not convey to you an interest in or to the Program, but only a limited
right of use revocable in accordance with the terms of this License Agreement.
4. No Warranty; Limitation of Liability. YOU ACKNOWLEDGE THAT THE PROGRAM IS PROVIDED ON AN "AS IS" BASIS WITHOUT
WARRANTY OF ANY KIND. LICENSOR MAKES NO REPRESENTATIONS OR WARRANTIES REGARDING THE USE OR PERFORMANCE OF
THE PROGRAM. LICENSOR EXPRESSLY DISCLAIMS THE WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
PURPOSE. LICENSOR SHALL HAVE NO LIABILITY TO CUSTOMER OR ANY THIRD PARTY FOR ANY LOSS OR DAMAGE CAUSED,
DIRECTLY OR INDIRECTLY, BY THE PROGRAM, INCLUDING, BUT NOT LIMITED TO, ANY INTERRUPTION OF SERVICES, LOSS OF
BUSINESS, LOSS OF DATA OR SPECIAL, CONSEQUENTIAL OR INCIDENTAL DAMAGES.
5. Severability. Should any term of this License Agreement be declared void or unenforceable by any court of competent jurisdiction,
such declaration will have no effect on the remaining terms hereof.
6. No Waiver. The failure of either party to enforce any rights granted hereunder or to take action against the other party in the event
of any breach hereunder shall not be deemed a waiver by that party as to subsequent enforcement of rights or subsequent actions in
the event of future breaches.
7. Update Checks. You acknowledge and agree to allow Inepro Back Office Suite version and license status details to be sent to Inepro
BV when you request to "Check for updates". This allows the Inepro Back Office Suite software to determine whether software
updates are available in real-time.
8. Service. Licensor will utilize its best efforts to maintain acceptable performance of services, but Licensor makes absolutely no
warranties whatsoever, express or implied, including warranty of merchantability or fitness for a particular purpose. Licensor cannot
guarantee continuous service, service at any particular time, or integrity of data stored or transmitted via its system or via the Internet.
9. Data. Licensor will not be liable for the inadvertent disclosure of, corruption or erasure of data transmitted or received or stored on its
system. Licensor shall not be liable to Licensee or any of its customers for any claims or damages which may be suffered by Licensee or
its customers, including, but not limited to, losses or damages of any and every nature, resulting from the loss of data, inability to access
the Software, or inability to transmit or receive information, caused by, or resulting from, delays, nondeliveries, or service interruptions
whether or not caused by the fault or negligence of Licensor.
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